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Altova DiffDog 2018
Altova DiffDog 2018 Professional Edition is a powerful XML differencing application that
intelligently finds differences between pairs of directories and between pairs of files.
DiffDog is a 32/64-bit Windows application that runs on Windows 7 SP1 with Platform Update,
Windows 8, Windows 10, and on Windows Server 2008 R2 SP1 with Platform Update or newer,
see also Support Notes.
Directories and files can be compared on different bases and according to a variety of options that
you can change quickly in the GUI.
The GUI also helps you to quickly spot and analyze differences, edit your documents directly
within the interface, merge differences, and instantly re-compare edited documents. The directory
comparison functionality is linked to the file comparison functionality, thus enabling you to
compare directories instantly and then to directly open and compare file pairs from within the
directory comparison.

Last updated: 21 June 2018
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Introduction
Altova website:

Diff tool

Altova® DiffDog® 2018 Professional Edition enables you to intelligently find differences
between a pair of directories and between a pair of documents. Directories and files can be
compared on different bases and according to a variety of options that you can change quickly in
the GUI. In addition, DiffDog allows you to synchronize the content of two directories and copy or
delete changed files with a mouse click.
This User Manual describes the interface and the various features of DiffDog, and provides
guidance on how to use DiffDog. It consists of the following parts:
An Introduction (this section), which provides an overview of DiffDog features, a
description of the available comparison modes, and an overview of the DiffDog interface.
Guidance on how to use DiffDog. These sections provide an overview of how to use the
file comparison and directory comparison features of DiffDog and also introduces you to
various ways in which you can put these features to efficient use.
Descriptions of how to navigate, merge, and export differences.
A User Reference, which contains a description of all the toolbar icons, menu
commands, as well as status and result messages of DiffDog.
An overview of the command line options in DiffDog and how to use DiffDog in source
control systems.
The User Manual is indexed so you can find topics quickly. Additionally, the onscreen Help
provides full text search (Help | Search): Keying in a search term in the onscreen Help will pop
up a list of topics in which the search term appears. This documentation is also available online
and in PDF format at the Altova website (https://www.altova.com/documentation.html).

Altova DiffDog 2018
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Support Notes
DiffDog runs on the following operating systems:
Windows 7 SP1 with Platform Update, Windows 8, Windows 10
Windows Server 2008 R2 SP1 with Platform Update or newer
Both the 32-bit and 64-bit platforms are supported.

© 2018 Altova Gmb H
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Product Features
DiffDog provides the following main features.
File Comparison
A file comparison in DiffDog is made in a File Comparison window. Files to be compared are
opened in separate panes of a File Comparison window by browsing in Windows Explorer-type
windows or from drop-down lists of previously opened files. DiffDog remembers file comparison
pairs, and, when you select a file for comparison, can provide a list of files with which the selected
file was previously compared.
Files can be compared as text or as structured XML. You can also compare binary files, however
DiffDog cannot display the changes within binary files, it can only detect whether or not a pair of
binary files is equal. A large range of navigation controls enables you to move easily among
differences.
A wide range of comparison options are available, thus allowing you to define what aspects of files
to compare and what aspects to ignore. Comparison options include settings for how whitespace
and blank lines should be treated, whether case-sensitivity should be considered or not, whether
differences should be indicated by line or character, whether certain node types, namespaces,
and the order of attributes and/or elements should be ignored, whether entities should be resolved,
etc.
If a file is modified outside DiffDog while it is open in a File Comparison window, DiffDog can watch
for changes and reload the file if required.
Differences within files are indicated with background colors, and corresponding differences in the
two panes are joined with lines, thus making visual analysis easier. Note that this does not apply
to binary files. Vertical and horizontal scrolling of the two files in Comparison windows can be
synchronized. This enables corresponding differences always to be displayed simultaneously.
File Editing and Merging in File Comparison Windows
After you have compared a file pair, files can be edited and saved directly within File Comparison
windows and you can specify whether and how backups of files you edit should be kept.
Comparisons can be done dynamically as you edit.
DiffDog provides high-level find-and-replace functionality, which also includes support for regular
expressions. Differences between files can be merged, i.e. a different block in one file can be
copied to replace the corresponding block in the other file. Editing and merging changes in either
file can be undone an unlimited number of times.
Directory Comparison
A directory comparison in DiffDog is made in a Directory Comparison window. The directories to
be compared are opened in separate panes of a Directory Comparison window. DiffDog provides a
drop-down list of recently compared directories from which to select. Additionally, once a directory
is selected to be opened in one pane, DiffDog can provide a list of directories with which that
directory was previously compared; as a result previously compared pairs can quickly be opened
in a Directory Comparison window. You can define filters to specify what file types to compare
and what file types to ignore in a directory comparison.
Directories can be compared on the basis of the sizes and timestamps of files within them (Quick

Altova DiffDog 2018
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Comparison Mode), or on the basis of the contents of files. The compared directories are
displayed as expandable/collapsible trees and show details such as file size and last modification
date. The view of the compared directories can be configured on the basis of the comparison
results. For example, equal directories and files can be hidden, and only non-equal folders and
files shown. Differences between directories and files are indicated with color-coding and easy-toidentify icons.
If a directory is modified outside DiffDog while it is open in a Directory Comparison window,
DiffDog can watch for changes and reload the directory if required. Non-equal directories and files
can be copied from one pane (directory) to the other. You can also synchronize the directories,
that is, copy all missing or updated files from one directory to the other or delete unneeded files.
File comparisons can be started directly from within a Directory Comparison window by doubleclicking a file in a directory.
Interface
Multiple comparison windows (directory and file) can be opened in DiffDog at a time. Directory
synchronization is done in a dialog box that can be opened from the Directory Comparison
window after you have run a directory comparison, and which allows you to customize the default
synchronization settings according to your needs.
The GUI has user-friendly menu layouts, intuitive toolbar icons, right-click quick menus, and a
status bar that summarizes the results of comparisons. You can customize the look of Directory
Comparison windows and File Comparison windows, including the background colors that are
used to highlight differences. Files can be viewed in Text View or Altova's Grid View.
The Text View of documents in File Comparison windows provides line-numbering, source-folding
(i.e. expandable and collapsible elements), indentation guides, bookmarking, syntax coloring, and
whitespace and linefeed indicators. Syntax coloring can be adjusted according to file type.
Grid View displays structured documents, such as XML documents, in a tabular grid. This
enables you to carry out large-scale changes easily (for example, inserting a column would insert
the node represented by the column in all the nodes represented by the rows of the grid).
Command Line
DiffDog can be called from the command line. The application can be integrated with any source
control system which provides the possibility to set up a path to the DiffDog executable.

© 2018 Altova Gmb H
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DiffDog Terminology
Terms used in this documentation are defined below.
Comparisons: DiffDog enables you to make two kinds of comparisons: File Comparisons and
Directory Comparisons (see below).
File comparison: A file comparison is the process of comparing two files. The term is also used
to refer to the display of results of the comparison.
File Comparison window: Each file comparison is displayed in a File Comparison window.
Multiple file comparisons can be open in DiffDog at a time, but only one may be active at any
given time.
Directory comparison: A directory comparison is the process of comparing two directories. The
term is also used to refer to the display of the results of the comparison.
Directory Comparison window: Each directory comparison is displayed in a Directory
Comparison window. Multiple directory comparisons can be open in DiffDog at a time, but only
one may be active at any given time.
Directories and Folders: These two terms are used interchangeably.
Difference: Two types of differences are distinguished: (1) differences between two compared
files, and (2) differences between two compared directories.
(1) A difference between two files that are compared as text denotes a line of text in a file that is
different from the corresponding line (if any) in the compared file. Note that the entire line is
considered to be a single difference—even if the option to show differences within lines is
selected. (This is significant when merging differences because the entire line will be merged;
merges are not carried out at the character level.) A line of text is considered to be different from
its corresponding line if one or more characters of text in it are different, if text is missing, or if a
line is present for which there is no corresponding line in the compared file.
A difference between two files that are compared as XML denotes a node that is different from the
corresponding node in the compared file. In general, nodes are considered different if the
corresponding text values do not match. What constitutes a difference can be further refined in
the Comparison Options dialog box.
(2) Differences between two compared directories are determined by comparing corresponding
files within the two compared directories. In Quick Comparison Mode, the file sizes and
timestamps of the corresponding files are compared. If one of these is different, the files are said
to be different. Alternatively, corresponding files within directories are compared on the basis of
their contents. Such comparisons are carried out as normal DiffDog file comparisons, and a
difference causes the files to be flagged as different. Also see the definition of Equal Files and
Non-Equal Files.
Equal Files: In directory comparisons, files that are identical according to the comparison
options, are said to be equal.
Non-equal Files: In directory comparisons, there are two types of non-equal files: (1) a different

Altova DiffDog 2018
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file (see definition of Difference above), and (2) a file that is present in one directory but not in the
other. Note that a non-equal file is not necessarily a different file.
Merging: Differences found in a filecomparison can be merged, that is, copied from one file to the
other. The block that is copied overwrites the corresponding block or space in the compared file.
In file comparisons, merges are performed for the active (current) difference, and can be performed
in either direction. Note that non-equal files in a Directory Comparison can also be copied from
one pane (directory) to the other.
Synchronizing: Two directories that are different are synchronized by copying or deleting,
respectively, all non-equal files and sub-folders from one directory to the other, or by deleting files
that are present in one directory but not in the other. The default synchronization options are
displayed in the Synchronize directories dialog box where they can be changed for the entire
directory. Additionally, you can also edit the synchronization actions for individual files or subfolders.

© 2018 Altova Gmb H
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Comparison Modes
Files and directories can be compared in DiffDog in several ways. The comparison mode is
indicated by the icons in the Comparison Mode toolbar. You can change the comparison mode
either by clicking a different toolbar icon or by selecting the desired mode from the Diff and
Merge menu.
The comparison mode you select is important. For example, identical files with different
timestamps will be indicated as same in Text Comparison Mode but as different in Quick
Comparison Mode. The available comparison modes are described below.

File comparison
When a File Comparison window is active, or when Quick Comparison Mode is toggled off in a
Directory Comparison window, you can select from among the following four file comparison
modes:
Text: Compares files as text files; compares directories with contents treated as text
files.
XML: Compares files as XML files; compares directories with contents treated as XML
files.
Binary: Compares files as binary files; compares directories with contents treated as
binary files.
File extension: Compares files as text or XML according to settings for file extensions,
which you can make in the File Types tab of the DiffDog Options dialog (Tools | DiffDog
Options); compares directories with contents treated as text files, XML files, Microsoft
Word files, or binary files according to file extension.

Directory comparison
When a Directory Comparison window is active, you can choose between Quick Comparison
Mode and one of the four file comparison modes described in the File comparison section above.
Quick comparison: Compares files within directories and sub-directories by size and
date modified. This mode is either toggled on or off. When toggled off, the four file
comparison modes become available. Selecting one of the file comparison modes causes
directories to be compared in terms of their contents as text, XML, or binary files.

Current Comparison Mode
DiffDog uses the concept of the current comparison mode. This is the comparison mode that is
current at any given time. For each type of comparison window (file and directory), a separate
current comparison mode exists at all times. The current comparison mode for each type of
comparison window is that comparison mode most recently selected by you in any of the open
comparison windows of that type. When the application is started, the current comparison modes
are the comparison modes that were current at the time the application was last closed.
Every File Comparison window and Directory Comparison window has a comparison mode.

Altova DiffDog 2018
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When new comparison windows (file or directory) are opened, they have the current comparison
mode for that type of comparison window (file or directory). Note that the current comparison
mode for file comparisons applies to new directory comparison windows if Quick Comparison
Mode is not the current comparison mode for directory comparisons.
If you change the comparison mode of a comparison window, then that comparison mode applies
to that particular comparison window. The comparison mode of other open comparison windows is
not affected. However, the newly selected comparison mode becomes the current comparison
mode and is applied to all comparison windows that are opened subsequently.

© 2018 Altova Gmb H
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The DiffDog Interface
The DiffDog interface displays multiple File Comparison windows and Directory Comparison
windows within the DiffDog application window. The schematic diagram below illustrates the main
parts of the interface. It is accompanied by a brief description of the various interface parts.

Title Bar
The Title Bar displays the application name (i.e., DiffDog) followed by the name of the active File
Comparison window or Directory Comparison window. At the right-hand side are buttons to
minimize, reduce or maximize, and close the DiffDog application window.

Menu Bar and Toolbars
The Menu Bar displays the menus. Each toolbar displays a group of icons for DiffDog commands.
You can reposition the menu bar and toolbars by dragging their handles to the desired locations.
At the right-hand side are buttons to minimize, reduce or maximize, and close the active
comparison window.

Altova DiffDog 2018
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File/Directory Comparison Window
Multiple File Comparison windows and/or Directory Comparison windows can be open at a time,
but only one of them is active. The name of the active comparison window appears in the title bar
and its name tab (at the bottom of the DiffDog application window) is highlighted and the name
itself is displayed in bold; the name tabs of the other open comparison windows are grayed out
and the names are displayed in normal font. To make another comparison window the active
comparison window, click its name tab.
Each comparison window (file/Microsoft Word or directory) has two panes of equal width arranged
side-by-side and a status bar for that comparison window below the two panes. Above each pane
is a file/directory selection area. This consists of a combo box, where you can enter the name of
the file/directory to be compared, or select a previously opened file or directory from the drop-down
menu. The buttons to the right of this area allow you to browse for files or directories, and to open
files, save files and refresh files. The file and directory that is opened in each pane can therefore
be opened independently of the file or directory in the other pane. Once a file/directory has been
opened in both panes of a comparison window, a comparison can be made.
In Directory Comparison windows, directories are displayed as trees, the levels of which can be
expanded/collapsed by double-clicking on a directory-level. Additionally, the width of individual
columns can be adjusted by dragging borders to the desired width. In File Comparison windows,
the view of the document can be customized using commands in the View and Text View
menus.

Comparison Window Status Bar
The status bar of a comparison window indicates the status of that comparison. If files or
directories have not been opened, this is indicated. If a comparison has been made, the type of
comparison is reported along with the result of the comparison. The comparison window status
bar should not be confused with the application status bar.

Application Status Bar
The application status bar appears at the bottom of the application window, and shows
application-level information. The most useful of this information are the tooltips that are displayed
here when you mouseover a toolbar icon. The application status bar should not be confused with
the comparison window status bar. If you are using the 64-bit version of DiffDog, this is indicated
in the status bar with the suffix (x64) after the application name. There is no suffix for the 32-bit
version.

© 2018 Altova Gmb H
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Comparing Files
Altova website:

File compare tool

This chapter provides instructions on how compare two files with DiffDog. The information
enclosed here is applicable to most file types.
Note:

To compare ZIP-conformant files and Office Open XML (OOXML) files, run a directory
comparison instead of a file comparison (since ZIP and OOXML files contain multiple
files). Otherwise, if you attempt to compare ZIP-conformant files using a file comparison,
DiffDog will prompt you to run a directory comparison instead. For more information, see
Comparing Directories.

A file comparison in DiffDog involves adding the files to the File Comparison window. The File
Comparison window enables you to view file differences side by side. For step-by-step
instructions, see Running a File Comparison.

File Comparison window

As illustrated above, the File Comparison window consists of two panes called Text View and Grid
View. The Text View is the default editor for most file types. It displays the content of the file,
while offering multiple navigation aids, such as word wrapping, code folding, line numbering,
syntax highlighting for numerous file types, as well as the ability to find and replace text or search
by regular expressions. In case of XML files, the Text View offers even more capabilities, such as
automatic highlighting of start and end tags, and pretty-printing. For more information, see Text
View.
The Grid View is applicable to well-formed files, typically XML documents. It is particularly useful if
you want to see the structure of the document at a glance, easily expand or collapse specific
sections, or modify content in table-like manner, without accidentally changing the XML tags. For
more information, see Grid View.

Altova DiffDog 2018
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If necessary, you can edit files directly in either the Text View or the Grid View (see Editing Files).
Changes can be saved back to the original file, or reverted (either using Undo, or by reloading the
original file from the disk). For information about merging differences from one file to another, see
Merging Differences.
If you are frequently comparing the same or similar sets of files, you can save the comparison as
a file and open it at a later time (see Saving and Loading Comparisons).
Various comparison options can be customized (see Modifying the File Comparison Options).

© 2018 Altova Gmb H
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Running a File Comparison
To run a file comparison with DiffDog:
1.

Open a new File Comparison window, if one is not already open. Note that, by default,
DiffDog starts with an empty File Comparison window, in which case you can skip this
step. To open a File Comparison window, select the menu option File | Compare Files
or click the Compare files

2.
3.

button in the Standard toolbar.

Choose a comparison mode that is appropriate for the file types being compared (binary,
text, XML, or extension-based). For more information, see Comparison Modes.
Select the files to be compared. There are various ways to do this, as follows:
In the left pane of an existing File Comparison window, click the Open
select a file in the Windows Open dialog box.
Enter the full path to a file and click the Apply

button and

button.

Drag a file from the Windows Explorer into the pane.
Select a previously compared file from the drop-down list.

Altova DiffDog 2018
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Repeat any of the steps described in step 3 for the right pane.

Alternatively, you can run a file comparison as follows:
1.

On the File menu, click Open (alternatively, press Ctrl+O).

2.
3.

In the Open comparison dialog box, select Compare files .
Browse for the files to be compared and click OK.

Another way to run a file comparison is as follows:
1.
2.

In Windows Explorer, select the two files to be compared. (To select multiple files in
Windows Explorer, hold the Ctrl key pressed while selecting a file.)
Right-click one of the files, and select Compare with Altova DiffDog command from the
context menu.

By default, when the two documents to be compared are loaded into the comparison window, a
comparison is automatically carried out. To enable or disable automatic comparison, do one of
the following:
On the Diff and Merge menu, select the Autostart Comparison menu command.
Click the Autostart Comparison (

) toolbar button.

In addition, comparisons can be explicitly started any number of times. To start a comparison
explicitly, do one of the following:
On the Diff and Merge menu, select the Start Comparison command.

© 2018 Altova Gmb H
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Comparing Files

Click the Start Comparison (

Running a File Comparison

) toolbar button.

When editing documents, they are compared dynamically as you type if the Compare while
Editing command is toggled on. To toggle this option on or off, do one of the following:
On the Diff and Merge menu, select the Compare while Editing command.
Click the Compare while Editing (

) toolbar button.

If the Show Options Before Comparison command is toggled on, then the Comparison
Options dialog box is displayed each time before the comparison is run (except when it is run
dynamically by DiffDog while you edit). This is useful if you wish to run comparisons with different
options. To toggle this option on or off, do the following:
On the Diff and Merge menu, select the Show Options Before Comparison
command.

Altova DiffDog 2018
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Modifying the File Comparison Options
The options of a file comparison can be changed in the Comparison Options dialog box. This
dialog box provides separate tabs for text and XML comparison. To open the Comparison Options
dialog box:
On the Tools menu, click Comparison Options.
In addition, the Diff and Merge menu offers several toggle commands which can be switched on
or off via the menu:
Show Options Before Comparison
Autostart Comparison
Compare while Editing
Support Recently Compared Pairs
General options for the comparison of files are furthermore available in the File comparison tab of
the DiffDog Options dialog box.

3.2.1

Options for Text Comparison
The Text tab of the Comparison Options dialog box displays the options that are used for text
comparison.
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View results
By selecting the Show differences within lines check box, you can display the differences on
character level. Note that the Compare as Text
differences within lines (see Comparison Modes).

button must be active in order to display

If the check box is deactivated, differences are displayed only on line level, that is, character level
differences are not highlighted. Only the line, as a whole, is indicated as being different.

Whitespace
See Comparison Options for Whitespace Characters.

Case sensitivity
Activate the Ignore case check box if upper and lower casing should be ignored when checking
for differences.

Lines
Here you define whether blank lines should be ignored.

3.2.2

Options for XML Comparison
The XML tab of the Comparison Options dialog box displays the options that are used for XMLbased comparison.
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View results
The Detailed differencing option enables you to show differences in detail or reduce the number
of differences (so that navigation is faster). With detailed differencing toggled off, consecutive
nodes that are different are displayed as a single node. This applies also to consecutive nodes on
different hierarchical levels, such as an element node and its child attribute node. Please note that
detailed differencing must be checked to enable merging and exporting differences.

Whitespace
See Comparison Options for Whitespace Characters.

Namespace/Prefix
These are options for ignoring namespaces and prefixes when searching for differences.

Entities
If Resolve entities is selected, then all entities in the document are resolved. Otherwise the files
are compared with the entities as is.

Text
If Ignore text is selected, then differences in corresponding text nodes are not reported. Only the
XML structure is compared but not the text content. This is useful when you want to compare two
XML structures and disregard the actual content. For example, let's assume that the Ignore text
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check box is selected. In this case, the following two XML files are equal (even though their
content differs).

Depth
If Ignore node depth is selected, then elements are treated as equal without regard to their
depth. For example, let's assume that the check box Ignore node depth is selected. In this
case, in a comparison like the one below, element <c> is equal on both sides, even though it is
nested deeper on the right side.

Note:

When the Ignore node depth check box is selected, merging and exporting differences
are not possible.

Case sensitivity
If the Ignore case check box is checked, then case is ignored, and you have the option of
ignoring or not ignoring case in node names.

Order
If Ignore order of child nodes is selected, then the relative position of the child nodes of an
Altova DiffDog 2018
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element is ignored, provided that the individual nodes within a node level have unique node names.
As long as an element node with the same name exists in each of the two sets of sibling nodes,
the two sets are considered to be equal. In the following example, the order of the <Name> and
<FirstName> nodes is different in the left and right file and is marked as different if the Ignore
order of child nodes option is deactivated.

Checking the Ignore order of child nodes option will ignore this difference in the comparison
window.

Note, however, that DiffDog can ignore the order of child nodes only if the node names on a
certain node level are unique. If several occurrences of a node appear, e.g. with different attributes
assigned, a node, if appearing in a different order, will always be considered unequal to an
element with the same name and attribute in the compared sibling set—even if the Ignore order
of child nodes is selected. If we add different attributes to the <Phone> node of our example,
then the difference in order of the three occurrences of the <Phone> node will appear in the
comparison window although the Ignore order of child nodes check box is selected.

In order to ignore the order of several occurrences of child nodes that have different attributes
assigned, you can add these attributes as comparison criteria. DiffDog provides two options: (i)
add all attributes and (ii) define a list of specific attributes, which in our example will both result in
the <Phone> nodes being displayed as equal. However, if you select the Specific attributes
option, you will first have to define an attribute group accordingly.

It may happen that several occurrences of child nodes appear that have also the same attribute
assigned (e.g. a person with more than one mobile phone number in our example). In the image
below, the All attributes radio button has been selected, however differences are still reported
since two mobile phone numbers are listed.
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In DiffDog you can cope also with this scenario by activating the Add element text as
comparison criteria check box. If element text, attribute value, and node name are identical and
only the order of the nodes is different, no differences will be reported.

Note that, if the Ignore Order option is specified, then the merge functionality also ignores the
order. If Ignore order of child nodes is unselected, then differences in order are represented as
differences.
The option of ignoring the order of attributes is also available, and applies to the order of attributes
of a single element. In the above example, the Ignore order of attributes option, has been
checked, and DiffDog therefore has ignored the order of the attributes of the <Person> node.
Note that the order of attributes will always be ignored, if the Ignore order or child nodes check
box is activated. In the screenshot below, both the Ignore order of child nodes and the Ignore
order of attributes check box are deactivated.

Ignore node types
Check the node types that will not be compared in the Compare session. Node types that may
be ignored are Attributes, CDATA, Comments, Processing Instructions, DOCTYPE statements,
and XML declarations.

Filter out specific elements/attributes
Enables you to define filters to set what elements and/or attributes should not be considered for
comparison. A filter is defined at the application level, which means that once a filter is defined, it
is available for every comparison. More than one filter can be defined, and, for every comparison,
the filter to be used is selected in the drop-down list in the Filter out specific elements/attributes
group box.

3.2.2.1

Defining Groups of Attributes
If you choose the Specific attributes radio button in the Order group box, the Define groups of
attributes as comparison criteria dialog box opens where you can create different lists of
attributes that shall be used as comparison criteria.
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Attributes to be considered as comparison criteria are organized in attribute groups, that is, you
first have to define an attribute group and then add the relevant attributes to the group. You can
select the attribute group to be used from the Specific attributes drop-down list in the
Comparison Options dialog box.
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To define groups of attributes to be considered as comparison criteria:
1.

Select the menu option Tools | Comparison Options... or click the Comparison

2.

Options
button in the Diff and Merge toolbar, and change to the XML tab.
In the "Order" group box, activate the radio button Specific attributes and click the
Browse
button next to the drop-down list to open the Define groups of attributes
as comparison criteria dialog box.

3.

4.

5.

3.2.2.2

In the "Attribute groups" group box, click the respective icon to append
or insert
a group to the list of groups and give it a name. Always define a group before specifying
attributes. Do not enter the attributes in the "Attribute groups" group box.
With the attribute group selected, in the "Add attributes as comparison" group box, click
the respective icon to append
or insert
elements to the list and enter the name of
the attribute that should be considered. Add an extra list element for each attribute.
When done with defining attribute groups, click OK. The defined attribute groups are now
available in the combo box in the Comparison Options dialog box.

Defining a Filter to Ignore Elements or Attributes for Comparison
Filters are defined by clicking the Define Filters
box, which pops up the Define Filters dialog box.

Altova DiffDog 2018
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In the image above, two filters (Filter1 and Filter2) have been defined. Filter1 specifies that
the elements email and name, and the attributes href and name, are to be ignored for
comparison.

To create a filter for ignoring element/attributes for comparison:
1.

Select the menu option Tools | Comparison Options... or click the Comparison
Options

button in the Diff and Merge toolbar, and change to the XML tab.

2.

In the Filter out specific elements/attributes group box, click the Define Filters
button to open the Define filters dialog box.

3.

In the Filters group box, click the respective icon to append
or insert
a filter to
the list of filters and give it a name.
With the filter selected, in the Ignore Elements/Attributes group box, click the respective

4.

5.
6.
7.

icon to append
or insert
elements and filters to the list. The Ele check box is
activated by default.
Deactivate the Ele check box and/or activate the Att check box, if required, and enter a
name for the element/attribute.
Optionally, repeat steps 4 and 5 for additional elements/attributes.
When done with defining a filter, click OK. The defined filters are now available in the
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combo box in the Comparison Options dialog box.

3.2.3

Comparison Options for Whitespace Characters
Whitespace characters are any of the following: space, tab, carriage return, and line feed. You
can change the comparison options for whitespace characters from the Tools | Comparison
Options menu.

When Compare as is option is enabled, Text A is considered equal to Text B if characters in
Text A (including whitespace characters) correspond to those in Text B. The whitespace
characters are relevant for comparison.
When Normalize option is enabled, Text A is equal to Text B if, after normalization, characters in
Text A correspond to those in Text B. “Normalization” means that multiple consecutive
occurrences of whitespace characters are replaced by a single space character. Also, the leading
and trailing whitespace characters are trimmed for each line of text.
Note:

In case of XML (
) comparison, the leading and trailing whitespace characters in
attribute values are trimmed.

When Strip all option is enabled, Text A is considered equal to Text B if, after stripping
whitespace characters, characters in Text A correspond to those in Text B. In other words, any
whitespace characters are stripped from the text and considered not relevant for comparison.
Note:

In case of XML comparison (
), whitespace characters that are outside attribute or
element values are disregarded for comparison. This is true for any of the whitespace
options above.

The following table illustrates differences when comparing text with each option, using text (
or Word comparison.
Text A

Text B

Compare as
is

Normalize

Strip all

"a"

"a "

not equal

equal

equal

"a"

" a"

not equal

equal

equal

"a a"

"a

not equal

equal

equal

a"

The following table illustrates differences when comparing text with each option, using XML (
comparison.
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Text A

Text B

<?xml version="1.0"

<?xml

<book id="1">
<author>Mark Twain</
author>
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Compar
e as is

Normali
ze

Strip all

equal

equal

equal

<book id=" 1 ">

not equal

equal

equal

<author>Mark
author>

not equal

equal

equal

version="1.0"

Twain</
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Displaying Differences in Files
After you start a comparison, the differences between the two files are displayed as blocks of
highlighted text and the results of the comparison are reported in the Comparison Window Status
Bar. Normally, Text View is used for displaying differences, however if you compare well-formed
files, you can also switch to Grid View.

3.3.1

Text View
Text View is the standard display mode for any file pair being compared in DiffDog. Notice that the
corresponding differences in the two documents are linked for easier identification and analysis.
When synchronized scrolling is toggled on, both documents scroll so that corresponding
differences are always in view simultaneously.

The current difference is highlighted in a different color than the other differences. In the
screenshot above the current difference is displayed in a darker green. These colors can be
changed in the DiffDog Options. It is important to know which difference is the current difference
because merging is always done for the current difference only. You can navigate among the
differences with the navigation commands that are available in the Diff and Merge menu and as
toolbar icons.

3.3.1.1

Using Visual Aids in Text View
Text View has multiple visual aids to make the display and editing of text easier. These include:
Line Numbers
Syntax Coloring
Bookmarks
Source Folding
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Indentation Guides
End-of-Line and Whitespace Markers
Zooming
Go-to-Line/Character
Pretty-printing
Word wrapping
Start and end tag matching
Text highlighting
Where applicable, you can toggle or customize the features above from the Text View Settings
dialog box. Settings in the Text View Settings dialog box apply to the entire application—not
only to the active document.

Text View Settings dialog b ox

To open the Text View settings dialog box, do one of the following:
On the Text View menu, select Text View Settings.
Click the Text View Settings button in the Text toolbar.
Some of the navigation aids can also be toggled from the Text toolbar, the application menu, or
keyboard shortcuts.

Text toolb ar

For reference to all shortcuts applicable in the File Comparison window, see the "Key Map"
section of the Text View Settings dialog box illustrated above.
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Line numbers
Line numbers are displayed in the line numbers margin, which can be toggled on and off in the
Text View Settings dialog box. When a section of text is collapsed, the line numbers of the
collapsed text are also hidden. A related command is the Go-to-Line/Character command.

Syntax coloring
Syntax coloring is applied according to the semantic value of the text. For example, in XML
documents, depending on whether the XML node is an element, attribute, content, CDATA
section, comment, or processing instruction, the node name (and in some cases the node's
content) is colored differently. You can enable or disable syntax coloring for various file extensions
(including custom extensions) from the Tools | DiffDog Options menu, File Types tab.

Bookmarks
Lines in the document can be separately bookmarked for quick reference and access. If the
bookmarks margin is toggled on, bookmarks are displayed in the bookmarks margin; otherwise,
bookmarked lines are highlighted in cyan.
The bookmarks margin can be toggled on or off in the Text View Settings dialog box.
You can edit and navigate bookmarks using commands in the Text View menu and Text toolbar.
Bookmarks can be inserted with the Text View | Insert/Remove Bookmark command, enabling
you to mark a line in the document for reference. A bookmark can be removed by selecting the
bookmarked line and then selecting the Text View | Insert/Remove Bookmark command. To
navigate through the bookmarks in a document, use the Text View | Next Bookmark and Text
View | Previous Bookmark commands. These bookmark commands are also available as icons
in the Text toolbar.

Source folding
Source folding refers to the ability to expand and collapse nodes and is displayed in the source
folding margin. The margin can be toggled on and off in the Text View Settings dialog box. To
expand or collapse portions of text, click the "+" and "-" nodes at the left side of the window. Any
portions of collapsed code are displayed with an ellipsis symbol. To preview the collapsed code
without expanding it, move the mouse cursor over the ellipsis. This opens a tooltip that displays
the code being previewed, as shown in the image below. Note that, if the previewed text is too big
to fit in the tooltip, an additional ellipsis appears at the end of the tooltip.
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The Toggle All Folds command in the Text toolbar toggles all nodes together to their expanded
or collapsed forms.

Indentation guides
Indentation guides are vertical dotted lines that indicate the extent of a line's indentation (see
screenshot above). They can be toggled on and off in the Text View Settings dialog box.

End-of-line markers, whitespace markers
End-of-line (EOL) markers and whitespace markers can be toggled on in the Text View Settings
dialog box. The screenshot below shows these markers in the document display; each dot
represents a whitespace.

Zooming in and out
You can zoom in and out of Text View by scrolling (with the scroll-wheel of the mouse) while
keeping the Ctrl key pressed. This enables you to magnify and reduce the size of text in Text
View. If you wish to increase the size of fonts, do this in the DiffDog Options dialog box.

Go to line/character
This command in the View menu and Text toolbar enables you to go to a specific line and
character in the document text.
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Pretty-printing
The Pretty-Print XML Text command reformats the active XML document in Text View to give a
structured display of the document. Each child node is offset from its parent by four space
characters.
To pretty-print an XML document, select the Text View | Pretty-Print XML Text menu
command, or click the

button in the Text toolbar

Note: The Pretty-Print XML Text command is not a toggle command. Once the command is
executed, the pretty-printed format cannot be undone by clicking the Pretty-Print XML Text
command again. To undo the pretty-printed format, use the Undo (Ctrl+Z or Alt+Backspace)
command.

Word wrapping
To toggle word wrapping in the currently active document, select the Text View | Word Wrap
menu command, or click the

button in the Text toolbar.

Start and end tag matching
When you place the cursor inside a start or end tag of a markup element, the corresponding start
or end tag is highlighted as well. When you edit the name of an element in a start tag, then the
end tag will be automatically edited as well.

Text highlighting
When you select text, all matches in the document of the text selection that you make are
highlighted automatically. The selection is highlighted in pale blue, and matches are highlighted in
pale orange. The selection and its matches are indicated in the scroll bar by gray marker-squares.
The current cursor position is given by the blue cursor-marker in the scroll bar.

3.3.2

Grid View
Altova website:

xml diff

Grid View can be used to display files that are well-formed, typically XML files. In Grid View, each
node is displayed as a row in a grid. This enables you to see the hierarchy in a graphical view, to
navigate through the document more easily, and to manipulate the structure of the document
using graphical mechanisms such as drag-and-drop.
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Note the following points, all of which can be seen in the screenshot above:
Node names are displayed in bold, their contents in normal font.
Different node types are indicated with different symbols. For example, attributes are
indicated with a red = symbol, elements with red angular brackets.
Nodes that are different from one document to the other are highlighted, with the current
difference being highlighted in a different color.
Corresponding differences in the two documents are joined with a line.
Nodes (rows) can be expanded and collapsed by clicking on the upward arrow button at the
extreme left of a grid row. To edit a node name or node contents, double-click the location where
you wish to insert the cursor.
Grid rows can be dragged to new locations by selecting the row and dragging it to the desired
location. Multiple nodes that are contiguously located can be selected for this operation. Individual
nodes can also be moved left or moved right using the respective Grid View menu commands (or
their toolbar icons). This changes the position of the node in the document hierarchy. Graphical
manipulation of structure and contents is further enhanced in Table View, which is another mode
of Grid View.
Columns can be resized by dragging their borders left or right.
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Displaying Repeating Elements as Table
In normal Grid View, each node has a grid row to itself, as shown in the screenshot below.

When an element occurs multiple times at the same hierarchical level (as is the case with the
member element in the screenshot above), it can be displayed as a table (screenshot below) in
which each occurrence of the element created as a table is represented as a row. The table
element's child nodes (attributes, elements, etc) are displayed as columns of the table.

To display multiple elements as table:
1.
2.

Select one of the occurrences of the element to be created as a table.
Select the menu option Grid View | Table | Display as Table or click the Display as
Table

button in the Grid toolbar.

To switch from Table View to the normal Grid View:
Select the table or any of its rows (not a column or cell), and click the Display as Table
toolbar icon.
The table element switches to normal Grid View.
Editing the table
The structure and contents of the table can also be edited using table mechanisms. For example,
rows (new table element occurrences) and columns (new child nodes for all table element
occurrences) can be inserted into the table, and the table can be sorted on one of its columns.
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In the screenshot above, the table (for member elements) is sorted on the pop column. (This was
done by selecting the pop column and then clicking the command Grid View | Table |
Ascending Sort.)
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Editing Files
After you have run a comparison and investigated the differences of the two files, you can edit the
content of the files directly in DiffDog. The available editing features differ for text-based and XMLbased files.
Changes to the content of both text-based and XML-based files are made in Text View. When
comparing well-formed XML-based files, DiffDog's Grid View allows you to also change the
document structure of the files.

Reloading files
You can always undo all changes you have made to a document since you last saved it, and
reload the file into DiffDog. A warning message will be displayed if you are about to lose changes.
To reload a file into DiffDog:

3.4.1

1.
2.

In the respective pane of a comparison window, click the Reload
button.
If the file has changed since you last saved it, a warning message is displayed.

3.

Click Yes if you want to reload, or No if you want to cancel the operation.

Changing the Content
In Text View, DiffDog provides syntax coloring and other visual aids such as line numbering,
indentation, and bookmarking, as well as powerful Find and Replace functionality that can help
with editing (see Using Visual Aids in Text View). A history of changes is maintained for each file
separately, and unlimited Undos are allowed.
If you have the Compare while Editing
option activated in the Diff and Merge menu, the
comparison of the files is refreshed continuously as you type.
To edit files:
Type in your changes in the respective pane of the File Comparison window.
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To undo changes made in a pane:
Place the cursor in the pane and click Edit | Undo or press Ctrl+Z.

3.4.2

Changing the Structure
The Grid View shows the hierarchical structure of well-formed, XML-based documents through a
set of nested containers, that can be easily expanded and collapsed to get a clear picture of the
document's structure. In Grid View contents and structure can both be easily manipulated. For
example, you can insert or append new elements or attributes, edit the content of the file, or drag
the individual elements to a different location in the document.
To modify the file structure in Grid View:
1.
2.

Click to select the element or attribute where you want to make the change.
Use the commands available in the Grid View menu (for example, GridView | Insert |
New Element). Alternatively, right-click an element and select the appropriate context
menu commands.
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Finding and Replacing Text
DiffDog offers powerful Find and Replace functionality that can help with editing. Please note that
the scope of the Find, Find next, and Replace commands is the active document, and not both
documents of a file comparison.
The Find and Replace options are different for Text View and Grid View. See Finding and
Replacing in Text View and Finding and Replacing in Grid View, respectively.

3.5.1

Finding and Replacing in Text View
To start a search in the Text View, press Ctrl+F (or select the menu command Edit | Find). You
can then search in the entire document or within a text selection for a search term that you enter
in the dialog.
Enter a string to find, or use the combo box to select a string from one of the last 10
strings.
When you enter or select a string to find, all matches are highlighted and the positions of
the matches are indicated by beige markers in the scroll bar.
The currently selected match has a different highlight color than the other matches, and
its position is indicated in the scroll bar by the dark blue cursor-marker.
The total number of matches is listed below the search term field, together with the index
position of the currently selected match. For example, 2 of 4 indicates that the second
of four matches is currently selected.
You can move from one match to the next, in both directions, by selecting the Previous
(Shift+F3) and Next

Altova DiffDog 2018
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To switch between the Find and Replace modes, click the down-arrow button
left.
To close the Find dialog, click the Close

51

at top

button at top right, or press Esc.

Note the following points:
The Find dialog is modeless. This means that it can remain open while you continue to
use Text View.
If text is selected prior to opening the dialog box, then the selected text is automatically
inserted into the search term field.
To search within a selection, do the following: (i) Mark the selection; (ii) Toggle on the
Find in Selection
option to lock the selection; (iii) Enter the search term. To search
within another selection, unlock the current selection by toggling off the Find in Selection
option, then make the new selection and toggle on the Find in Selection
option.
After the Find dialog is closed, you can repeat the current search by pressing F3 for a
forward search, or Shift+F3 for a backward search. The Find dialog will appear again in
this case.

Find options
Find criteria can be specified via buttons located below the search term field. When an option is
toggled on, its button color changes to blue. You can select from the following options:
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Icon

Description

Match case

Performs a case-sensitive search when toggled on ("Address" is
not the same as "address").

Match whole word

Only the exact words in the text will be matched. For example, for
the input string fit, with Match whole word toggled on, only the
word fit will match the search string; the fit in fitness, for example,
will not.

Regular
expression

If toggled on, the search term will be read as a regular expression.
See "Using regular expressions" below.

Find anchor

When a search term is entered, the matches in the document are
highlighted and one of these matches will be marked as the current
selection. The Find anchor toggle determines whether that first
current selection is made relative to the cursor position or not. If
Find anchor is toggled on, then the first currently selected match
will be the next match from the current cursor location. If Find
anchor is toggled off, then the first currently selected match will
be the first match in the document, starting from the top.

Find in selection

When toggled on, locks the current text selection and restricts the
search to the selection. Otherwise, the entire document is
searched. Before selecting a new range of text, unlock the current
selection by toggling off the Find in Selection option.

Using regular expressions
You can use regular expressions (regex) to find a text string. To do this, first, switch the Regular
expression
option on. This specifies that the text in the search term field is to be evaluated as
a regular expression. Next, enter the regular expression in the search term field. For help with
building a regular expression, click the Regular Expression Builder
button, which is located
to the right of the search term field. Click an item in the Builder to enter the corresponding regex
metacharacter/s in the search term field. The screenshot below shows a simple regular
expression to find email addresses.
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The following custom set of regular expression metacharacters are supported when finding and
replacing text.
.

Matches any character. This is a placeholder for a single character.

(abc)

The ( and ) metacharacters mark the start and end of a tagged expression. Tagged
expressions may be useful when you need to tag ("remember") a matched region for
the purpose of referring to it later (back-reference). Tagged expressions are similar to
matched subexpressions (indexed groups) in the .NET flavour of regular
expressions. Up to nine sub-expressions can be tagged (and then back-referenced
later).
For example, (the) \1 matches the string the the. This expression can be
literally explained as follows: match the string "the" (and remember it as a tagged
region), followed by a space character, followed by a back-reference to the tagged
region matched previously.

\n

Where n is 1 through 9 , n refers to the first through ninth tagged region (see above).
For example, if the search string was Fred\([1-9]\)XXX and the replace string
was Sam\1YYY, when applied to Fred2XXX this would generate Sam2YYY.

\<

Matches the start of a word.

\>

Matches the end of a word.

\

Escapes the character following the backslash. In other words, the expression \x
allows you to use the character x literally. For example, \[ would be interpreted as
[ and not as the start of a character set.

[...]

Matches any characters in this set. For example, [abc] matches any of the
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characters a, b or c. You can also use ranges: for example [a-z] for any lower
case character.
[^...]

Matches any characters not in this set. For example, [^A-Za-z] matches any
character except an alphabetic character.

^

Matches the start of a line (unless used inside a set, see above).

$

Matches the end of a line. For example, A+$ matches one or more A's at end of line.

*

Matches zero or more occurrences of the preceding expression. For example, Sa*m
matches Sm, Sam, Saam, Saaam and so on.

+

Matches one or more occurrences of the preceding expression. For example, Sa+m
matches Sam, Saam, Saaam and so on.

See also Example: Replacing Text Using Regular Expressions.

Replacing text
To replace text, do the following:
1.

Press Ctrl+H (or select the menu command Edit | Replace) to open the Replace dialog.
(Alternatively, you can switch to Replace mode of the Find/Replace dialog by clicking the
down-arrow button

2.

3.

at the top left of the dialog.)

Enter the string to be replaced in the Find field, and enter the new string in the Replace
field. The number of text matches to replace and the index of the currently selected
match is displayed below the Replace field. Also, the locations of matches are indicated
in the scroll bar by beige markers.
The Replace Next and Replace All buttons are located to the right of the Replace field.
If you click Replace Next, one of the following happens: (i) If the cursor is located
adjacent to a match or inside a match, then the match is replaced; (ii) if the cursor is
located outside a match, it jumps to the next match. Click Replace All to replace all
matches.

Note the following points:
To replace text within a selection—rather than the entire document—do the following: (i)
Mark the selection; (ii) Toggle on the Find in Selection
option to lock the selection;
(iii) Enter the Find and Replace text strings; (iii) Click Replace Next or Replace All as
required. To replace text within another selection, unlock the current selection by toggling
off the Find in Selection
in Selection

Altova DiffDog 2018

option, then make the new selection and toggle on the Find

option to lock the new selection.
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To undo a replace action, press Ctrl+Z or select Edit | Undo.

Finding and replacing special characters
You can search for any the following special characters within text, provided that the Regular
expression option
is enabled:
\t (Tab)
\r (Carriage Return)
\n (New line)
\\ (Backslash)
For example, to find a tab character, press Ctrl + F, select the
enter \t in the Find dialog box.

option, and then

The special characters above can also be used as replacement text. For example, to replace all
occurrences of semi-colon by carriage returns within the text "A;B;C;D", use the following find and
replace options:

The outcome is:
A
B
C
D

3.5.2

Finding and Replacing in Grid View
To search for text in Grid View:
1.
2.

Place the cursor into the pane in which you want to search for text.
Select the menu option Edit | Find or press Ctrl+F.
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Enter the text you want to search for into the Find what field.
To restrict your search, select the required XML node type or DTD declarations to be
searched in the Types group box.
Click Find Next.
To jump to the next found occurrence, press F3.

To replace text in Grid View:
1.
2.

Place the cursor into the pane in which you want to search for text.
Select the menu option Edit | Find or press Ctrl+H.
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Types
In the Types group box, you can select or deselect various XML node type or DTD declarations to
be searched. The Set all and Clear all buttons enable you to check or uncheck all options with a
single click.
Search in
You can search only the names and/or the contents of nodes by activating the respective check
boxes in the Search in group box.
Settings
Match case finds the text string only if the casing in the document is the same as that in the
entry. Match whole text only finds the text string only if, in the document, it is delimited by
spaces.
Where
The scope of the search can be restricted to the current selection or the whole file can be
searched.
Direction
The Up and Down options define whether the search should progress upwards or downwards from
the current selection or cursor location.

3.5.3

Example: Replacing Text Using Regular Expressions
This example illustrates how to find and replace text using regular expressions. In many cases,
finding and replacing text is straightforward and does not require regular expressions at all.
However, there may be instances where you need to manipulate text in a way that cannot be
done with a standard find and replace operation. Consider, for example, that you have an XML file
of several thousand lines where you need to rename certain elements in one operation, without
affecting the content enclosed within them. Another example: you need to change the order of
multiple attributes of an element. This is where regular expressions can help you, by eliminating a
lot of work which would otherwise need to be done manually.

Example 1: Renaming elements
The sample XML code listing below contains a list of books. Let's suppose your goal is to replace
the <Category> element of each book to <Genre>. One of the ways to achieve this goal is by
using regular expressions.
<?xml version="1.0" encoding="UTF-8"?>
<books xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="books.xsd">
<book id="1">
<author>Mark Twain</author>
<title>The Adventures of Tom Sawyer</title>
<category>Fiction</category>
<year>1876</year>
</book>
<book id="2">
<author>Franz Kafka</author>

© 2018 Altova Gmb H

Altova DiffDog 2018

58

Comparing Files

Finding and Replacing Text

<title>The Metamorphosis</title>
<category>Fiction</category>
<year>1912</year>
</book>
<book id="3">
<author>Herman Melville</author>
<title>Moby Dick</title>
<category>Fiction</category>
<year>1851</year>
</book>
</books>

To solve the requirement, follow the steps below:
1.

Press Ctrl+H to open the Find and Replace dialog box.

2.
3.

Click Use regular expressions
.
In the Find field, enter the following text: <category>(.+)</category> . This regular
expression matches all category elements, and they become highlighted.

To match the inner text of each element (which is not known in advance), we used the
tagged expression (.+) . The tagged expression (.+) means "match one or more
occurrences of any character, that is .+ , and remember this match". As shown in the
next step, we will need the reference to the tagged expression later.
4.

In the Replace field, enter the following text: <genre>\1</genre> . This regular
expression defines the replacement text. Notice it uses a back-reference \1 to the
previously tagged expression from the Find field. In other words, \1 in this context means
"the inner text of the currently matched <category> element".

5.

Click Replace All
and observe the results. All category elements have now been
renamed to genre, which was the intended goal.

Example 2: Changing the order of attributes
The sample XML code listing below contains a list of products. Each product element has two
attributes: id and a size. Let's suppose your goal is to change the order of id and size
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attributes in each product element (in other words, the size attribute should come before id).
One of the ways to solve this requirement is by using regular expressions.
<?xml version="1.0" encoding="UTF-8"?>
<products xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="products.xsd">
<product id="1" size="10"/>
<product id="2" size="20"/>
<product id="3" size="30"/>
<product id="4" size="40"/>
<product id="5" size="50"/>
<product id="6" size="60"/>
</products>

To solve the requirement, follow the steps below:
1.

Press Ctrl+H to open the Find and Replace dialog box.

2.
3.

Click Use regular expressions
.
In the Find field, enter the following: <product id="(.+)" size="(.+)"/> . This regular
expression matches a product element in the XML document. Notice that, in order to
match the value of each attribute (which is not known in advance), a tagged expression
(.+) is used twice. The tagged expression (.+) matches the value of each attribute
(assumed to be one or more occurrences of any character, that is .+ ).
In the Replace field, enter the following: <product size="\2" id="\1"/> . This regular
expression contains the replacement text for each matched product element. Notice that
it uses two references \1 and \2 . These correspond to the tagged expressions from the
Find field. In other words, \1 means "the value of attribute id" and \2 means "the value of
attribute size".

4.

6.

Click Replace All
and observe the results. All product elements have now been
updated so that attribute size comes before attribute id.
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Saving Files
To save a document you have edited in DiffDog, use the Save
or Save As
buttons in the
respective panes of the comparison window. Files can also be saved using the Close, Close All,
and Save commands in the File menu.
In the File comparison tab of the DiffDog Options dialog box, you can also specify whether and
how backup files should be saved.
To save a file:
Do one of the following:
To save an individual file, click the Save

button in its pane of the comparison window.

To save an individual file under a new name or path, click the Save As
button in its
pane of the comparison window. The Windows Save As dialog box appears where you
can specify the new name or path for the file.
To save both files of a comparison, select the menu option File | Save. The Save files
dialog box appears where you can select the files to be saved or choose to discharge the
changes.
To save and close the files of a comparison:
1.
2.
3.

Click the tab of the comparison window that contains the files you want to save and
close.
Select the menu option File | Close.
If a file contains unsaved changes, the Save files dialog box appears. Make sure that the
file's check box is selected and click Save selected.
The file is saved and the comparison window is closed.

To save and close the files of all comparisons:
1.
2.

Select the menu option File | Close all.
For every comparison window that contains a file with unsaved changes, the Save files
dialog box appears. Make sure that the file's check box is selected and click Save
selected.
The file is saved and the comparison window is closed.
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Comparing Directories
Altova website:

Folder compare tool

In DiffDog, directories and, optionally, their sub-directories are compared in Directory Comparison
windows. Here you can compare, merge, or synchronize directories. There are two ways in which
DiffDog compares directories:
By comparing the sizes and timestamps of files in the directories. This comparison mode
is called Quick Comparison Mode.
By comparing the contents of files in directories. This comparison mode is Text
Comparison Mode, or XML Comparison Mode, or Binary Comparison Mode, or
Extensions Comparison Mode.

To start a directory comparison in DiffDog, you can either directly choose two directories to
compare or first open an empty Directory Comparison window and then select the directories to
be compared. Alternatively, you can also select two directories in Windows Explorer, right-click
and select Compare with Altova DiffDog from the context menu. This will open a new instance
of DiffDog and display the selected folders in a Directory Comparison Window.
The comparison will start automatically unless you have deactivated the Autostart Comparison
option in the Diff and Merge menu. You can change the comparison mode as desired and restart
the comparison. In addition, to eliminate differences, DiffDog allows you to copy files from one
pane to the other.
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To open a directory comparison window:
Do one of the following:
Select the menu option File | Open or press Ctrl+O. Then do the following:
1.
2.
3.
4.
5.

Select Compare directories in the Open comparison dialog box.
Choose the directories to be compared in the Content group box.
Optionally, select a filter from the File/directory filter drop-down list.
Optionally, activate the Include subdirectories check box.
Click OK.

A new Directory Comparison window containing the selected directories is opened.
Select the menu option File | Compare Directories or click the Compare directories
icon in the Standard toolbar. An empty Directory Comparison window is opened.

ZIP and OOXML files
ZIP-conformant files are regarded as directories if the ZIP conformant file option is
selected as the default file comparison mode for *.zip files on the File types tab of the DiffDog
Options dialog (this is the default setting). You can then select a ZIP file as one of the directories
in a directory comparison, show the content of a ZIP file if it appears as a file in a directory
comparison, and also copy and merge files that are contained in the ZIP file.
Office Open XML (OOXML) files—which can be thought of as a specialized form of ZIP archives—
are also opened for comparison in directory comparison windows. After the content of the OOXML
file is displayed in the directory comparison window, you can browse for the document.xml file
and open it in a file comparison window.
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Opening a Directory Comparison Window
When opening a new Directory Comparison window, the Directory Comparison is given a name of
the form Directory compare X, where X is an integer indicating that directory comparison's
position in the sequence of directory comparisons opened in the current DiffDog session. This
name appears in a tab at the bottom of the window.

Note that the Compare Directories command opens only the Directory Comparison window; it
does not open any directory within the window. The two directories to be compared must be
opened subsequently in the panes of the comparison window, one in each pane.
To open an empty Directory Comparison window:
Select the menu option File | Compare Directory or click the Compare directories
button in the Standard toolbar.
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Selecting Directories for Comparison
Directories can be selected for comparison in various ways. You can open the directories in a new
Directory Comparison window, re-open a previous comparison, or change the directories in the
currently open Directory Comparison window.

To open directories in a new Directory Comparison window:
1.
2.
3.
4.
5.
6.

Select the menu option File | Open or press Ctrl+O.
Select Compare directories.
Enter the path to the first and the second directory, or click Browse and select a folder
from the system.
Optionally, choose a filter from the File/Directory filter drop-down list if you want to
restrict the displayed content of the directories to certain file types.
If required, select the Include subdirectories check box.
Click OK. The selected directories are opened in a new Directory Comparison window.

To select directories in the active Directory Comparison window:
1.

In the left or right pane of an existing Directory Comparison window, do one of the
following:
Click the Open

icon and select a directory in the Windows Open dialog box.

Enter the full path of a directory and click the Apply
button.
Select a previously compared directory from the drop-down list.

To start a directory comparison from Windows Explorer:
1.
2.

Select two directories in Windows Explorer.
Right-click and choose Compare with Altova DiffDog from the context menu.

A new instance to DiffDog is opened, the selected folders are displayed in a Directory Comparison
window, and the comparison is started automatically.

© 2018 Altova Gmb H

Altova DiffDog 2018

66

4.3

Comparing Directories

Modifying the Directory Comparison Options

Modifying the Directory Comparison Options
When comparing directories, the comparison mode you choose determines how the content of
the directories in the left and right pane of the Directory Comparison window are compared. The
basic comparison mode switch is the Quick Comparison toggle. In order to access Text
Comparison Mode, or XML Comparison Mode, or Binary Comparison Mode, or Extensions
Comparison Mode, Quick Comparison must first be toggled off.
You can also define which types of files will be displayed in the Directory Comparison window by
applying a filter. In addition, the Diff and Merge menu offers several toggle commands which can
be switched on or off via the menu:
Show Options Before Comparison
Autostart Comparison
Compare while Editing
Support Recently Compared Pairs
General options for the comparison of directories are furthermore available in the Directory
comparison tab of the DiffDog Options dialog box.
Note: If a new Directory Comparison window is opened, it assumes the comparison options of the
last comparison window (file or directory) to have had any of its comparison options modified.
To change the mode for directory comparison:
Do one of the following:
To use Quick Comparison Mode, toggle on Quick Comparison by selecting the menu
option Diff and Merge | Compare only Size and Modification Date or activating the
Quick Comparison
icon in the Comparison Mode toolbar.
Make sure that Quick Comparison is toggled off and select one of the following
comparison modes from the Diff and Merge menu or activate its corresponding icon in
the Comparison Mode toolbar:
Textual Comparison Only
Compare as XML
Compare as Binary
Compare According to File Extension Settings
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Running a Directory Comparison
When the two directories to be compared are loaded into the Directory Comparison window, a
comparison is automatically carried out if the Autostart Comparison command is toggled on
(which is the default setting) or if you have selected directories in Windows Explorer and used the
Compare with Altova DiffDog context menu command. In addition, comparisons can be
explicitly started any number of times with the Start Comparison command.
If you double-click a file in the Directory Comparison window, this file and the corresponding file in
the compared directory are opened in a new File Comparison window and compared immediately.
Filtering the content of compared directories
The Directory content toolbar contains a drop-down list from which you can select a filter to be
applied to the Directory Comparison window. You can change this filter at any time prior to or after
a comparison, or change the definition of a filter as well as add a new filter.
To run a filtered directory comparison:
Do one of the following:
When selecting directories for comparison using the File | Open menu option, select a
filter from the File/Directory filter drop-down list in the Open Comparison
dialog box.

If you have already opened a Directory Comparison window, select a filter from the dropdown list that is available in the Directory content toolbar.

The content in the Directory Comparison window is updated and a comparison is started
immediately.
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Configuring the View
In Directory Comparison windows, you can toggle on and off the display of the Size and Last
Modified columns by right-clicking the Header of either pane and then clicking Size and/or Last
Modified.

The column width can also be changed by dragging column borders to the desired location.

Controlling what files are displayed
You can configure the view of individual Directory Comparison windows to display files on the
basis of their compared status. For example, you can opt to not display all equal files, or to not
display non-comparable files, or to display files that are unequal and newer in the left pane but to
not display files that are unequal and newer in the right pane. To do this, you use a set of simple
toggle commands that are available as toolbar icons. Note that the toggle is on when the icon has
a border around it (as depicted below).
Show/Hide equal: Shows or hides files and sub-directories that are equal in the left and
right pane.
Show/Hide left newer: Shows or hides files that are unequal, and where the never
version of the file is located in the left pane.
Show/Hide right newer: Shows or hides files that are unequal, and where the never
version of the file is located in the right pane.
Show/Hide left only: Toggles on and off the display of subdirectories and files that are
present in the left pane only.
Show/Hide right only: Toggles on and off the display of subdirectories and files that are
present in the right pane only.
Show/Hide not comparable: Toggles on and off the display of files that are not
comparable. Files are considered to be non-comparable if they cannot be compared in
the selected Comparison Mode. For example, in XML Comparison Mode, file types that
have been specified as not being XML-conformant are considered to be not comparable.
Show/Hide empty directories: Toggles on and off the display of empty directories.

Displaying sub-directories
If, during opening the directories using the File | Open menu option, you have decided to not
show sub-directories in the Directory Comparison window, you can nevertheless activate this
option in any stage of the comparison by clicking the Include Subdirectories
button in the
Directory content toolbar. Clicking the button again will toggle the display of sub-directories off
again. With the button toggled on, you can use the following buttons to customize the display of
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sub-directories:
Collapse: Collapses all directories that have subdirectories. Note that this command will
collapse all sub-directories in both panes. To collapse a single sub-directory, doubleclick on it.
Expand: Expands all directories that have subdirectories.
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Displaying Differences in Directories
The directory comparison results are displayed as trees in both panes. If sub-directories are
displayed, they can be collapsed and expanded by double-clicking the icons for them. The
comparison results are indicated with colors and icons as described below.

The colors in which file names are displayed are significant. DiffDog displays the individual files in
a Directory Comparison window in the following colors:
Black: The file is equal in the selected comparison mode.
Names of files that cannot be compared in the selected comparison mode are also
displayed in black.

Blue: The file is present in the directory in which it is displayed, but not in the other
directory.

Red: The file is present in both directories, but is not equal in the selected comparison
mode. Note that the newer file is colored a brighter red.

Sub-directory names are always displayed in black.

Folder icons
The following icons are used for directories in Directory Comparison windows. Note that expanded
directories are shown with their top right corners turned down (left icon):
Directories that contain files that are equal in the selected comparison mode are
indicated with a blank body.
Directories that contain different files in the selected comparison mode are indicated
with a not-equal sign.
Directories that contain files that are not present in the corresponding directory in the
other pane are indicated with a blue exclamation mark.
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Directories that have both extra files and different files are indicated with an
exclamation mark and a not-equal sign.

ZIP and OOXML icons
The following icons for ZIP and OOXML files are used for directories in Directory Comparison
windows:
If the ZIP archives/OOXML files contain files that are equal in both panes, the ZIP symbol
displays two blank file icons.
ZIP archives/OOXML files that contain different files are indicated with a not-equal sign.
ZIP archives/OOXML files that contain files that are not present in the corresponding ZIP
in the other pane are indicated with a blue exclamation mark. Note that the exclamation
mark is displayed in the pane where the additional file is located.
ZIP archives/OOXML files that have both extra files and different files are indicated with
an exclamation mark and a not-equal sign.

File icons
The following file icons are displayed in Directory Comparison windows:
Files that are equal in the selected comparison mode are displayed with a blank body.
Files that are non-equal in the selected comparison mode are displayed with a not-equal
sign.
Files that are not present in the other pane are displayed with a blue exclamation mark.

Comparison symbols
The following symbols appear in the column between the two panes and indicate the results of the
directory comparison, specifically the relationship between the files on either side of the symbol.
Note that these symbols are only displayed for files and not for subdirectories.
Files are equal in the selected comparison mode.
Files are different in the selected comparison mode.
Files cannot be compared in the selected comparison mode.

© 2018 Altova Gmb H

Altova DiffDog 2018

72

4.7

Comparing Directories

Comparing Files from within a Directory Comparison

Comparing Files from within a Directory Comparison
Double-clicking a file in any of the two directories opens that file and its corresponding file in the
other directory in a File Comparison window. If a corresponding file does not exist, no file is
opened in the second window.
The new file comparison is opened in the current comparison mode of the directory comparison or
—if Quick Comparison is the comparison mode of the directory comparison—in the comparison
mode that was the current file comparison mode (Text, XML, Binary, or Extensions) when the
directory comparison was opened, respectively.
You can continue to work in the File Comparison window as in a regular file comparison session.

The new feature will allow to save/load comparisons in DiffDog i.e. selected files/directories and
according options to exactly reproduce current comparison.
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Synchronizing Directories
In addition to the merging functionality, which allows you to copy individual files from one pane to
the other, DiffDog in the Diff and Merge menu also provides the Synchronize directories
option. This option allows you to synchronize the content of the two directories in one single step.

The Synchronize directories dialog box can be opened exclusively from a Directory Comparison
window, that is, there is no independent menu option available and you have to open a Directory
Comparison window first. After two directories have been compared in a Directory Comparison
window, you have the following options:
Synchronizing the currently displayed directories including their sub-directories
Selecting a single sub-directory in the Directory Comparison window and synchronizing
only that particular sub-directory
In the Mode group box of the Synchronize directories dialog box, you can choose from two
options: (i) Fully synchronize all sub-directories and files (left to right or right to left), or (ii) adapt
the synchronization settings. You can always change the synchronization actions for the
individual files by activating the Enable manual override of synchronization
actions check box, and, finally, synchronize the two directories.
To open the Synchronize directories dialog box:
1.
2.

Make sure that the two directories that you want to synchronize are displayed in a
Directory Comparison window and that you have compared them.
Do one of the following:
To synchronize the currently displayed directories including their sub-directories, select
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the menu option Diff and Merge | Synchronize directories or click the Synchronize
button in the Directory content toolbar.
To synchronize only the sub-directory that is selected in the Directory Comparison
window, select the menu option Diff and Merge | Synchronize selected directory or
click the Synchronize selected

4.8.1

button in the Directory content toolbar.

Full Synchronization
If you have activated the Fully synchronize all sub-directories and files check
box in the Mode group box, you can choose whether you want to synchronize (i.e., copy) the files
from left to right or from right to left by selecting the corresponding radio button. This option will
perform the following actions:
All different files will be overridden
Files that only exist in the source directory will be copied to the target directory
Additional files that exist in the target directory will be deleted permanently (respectively
moved to the recycle bin, if possible)
No backup files will be created
You can, however change the default synchronization settings by activating the Enable manual
override of synchronization actions check box.

The Enable manual override of synchronization actions check box enables you
to fine-tune your synchronization actions for one or more particular files or sub-directories. If this
check box is activated, the Sync Action column provides a drop-down list where you can choose
a synchronization action for an individual file or sub-directory and thus override the settings that
have been defined on directory level.

4.8.2

Adapting the Synchronization Settings
Within a running session of DiffDog, the Synchronize directories dialog box opens with the
previously saved settings for directory synchronization and displays them in the upper part of the
dialog. When a new DiffDog instance (or session) is opened, the Synchronize directories dialog
box opens for the first time with the default settings. Using the drop-down lists and check boxes,
you can adapt those settings so as to meet the requirements for synchronizing the currently
displayed directories.

In the Different files group box, you define which files are to be copied, that is, whether older or
newer files are to be kept, and whether they should be copied to the right, or left directory, or to
both directories. The default option copies newer files to the opposite side so that only the newer
version of the file will be kept.
You can choose from among the following options:

Altova DiffDog 2018

© 2018 Altova Gmb H

Comparing Directories

Synchronizing Directories

75

No action: This option ignores different files.
Copy newer files: This option copies the newer version of a file to the opposite directory.
You can use the Left to right and Right to left check boxes to limit the
update to one particular directory. Check both boxes to copy the newer files to the
opposite directory and thus update both directories.
Copy older files: This option copies the older version of a file to the opposite directory.
You can use the Left to right and Right to left check boxes to limit the
update to one particular directory. Check both boxes to copy the older files to the
opposite directory and thus update both directories.
The Create backup files check box allows you to keep a backup of a file's previous version
in the directory. If activated, the previous version is saved with a .BAK extension before the
updated version is copied to the directory.

The Enable manual override of synchronization actions check box enables you
to fine-tune your synchronization actions for one or more particular files or sub-directories. If this
check box is activated, the Sync Action column provides a drop-down list where you can choose
a synchronization action for an individual file or sub-directory and thus override the settings that
have been defined on directory level.

The Missing files/directories group box determines, how missing files and/or directories are to be
handled when directories are synchronized. You can choose, whether these options are to be
applied to files and directories or to directories (when copying) or files (when deleting) only.
Furthermore, you can define, whether deleted items should be moved to the Recycle Bin if
possible or be deleted permanently.
The following options are available for missing files and directories:
No action: No synchronization for files that are present in only one of the directories.
Copy missing: Missing files are copied to the opposite directory. You can use the Left
to right and Right to left check boxes to limit the update to one particular
directory. Check both boxes to copy missing files to the opposite directory and thus
update both directories.
Delete missing: Missing files are deleted from the opposite side. You can use the Left
only and Right only check boxes to restrict the deletion to one particular directory.
Check both boxes to delete missing files from the opposite directory and thus delete
missing files from both directories.

4.8.3

Changing the Synchronization Actions
Basically, the synchronization options are defined for the directories as a whole. You can,
however, change the synchronization actions for one or more individual files or sub-directories
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manually if the Enable manual override of synchronization actions check box is
activated.

Warning: If you apply a delete action to a sub-directory, also all files that are contained in this
directory will be deleted on the chosen side. Since equal files are not displayed in the
Synchronize directories dialog, DiffDog displays a warning so as to alert you to this fact.

To define synchronization actions manually for individual files:
1.
2.
3.

Make sure that the Enable manual override of synchronization actions
check box is activated.
Optionally, change the default synchronization option for the directories in the Different
files and Missing files/directories group boxes.
To change the pre-selected synchronization action for a particular file, click the drop-down
list in the Sync Action column between the two directory panes and select one of the
following options:
<blank >: No synchronization for this file.
copy >: The file will be copied from the left side to the right side without considering
which file is newer.
< copy: The file will be copied from the right side to the left side without considering
which file is newer.
delete >: The file will be deleted on the right side.
< delete: The file will be deleted on the left side.
< delete >: The file will be deleted on both sides.
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If you choose to delete a sub-directory, click OK in the warning message informing you
that also equal files will be deleted.
A message pops up informing you that manual changes will not be considered when
changing the synchronization options.

5.

Click OK.
The synchronization action is indicated with a different background color. If you later on
change the overall settings for the directories and the settings happen to match the
manually changed action, the background color will be removed again.

To reset manual synchronization actions:
1.

Do one of the following:
Click the Reset all button.
Deactivate the Enable manual override of synchronization actions
check box.

2.

4.8.4

Click OK in the message box that appears.

Starting a Directory Synchronization
After you have configured the synchronization actions on directory level and, if applicable, for
individual files, you have to start a directory synchronization manually.
To start a directory synchronization:
1.
2.
3.

Open a Directory Comparison window and run the comparison.
Open the Synchronize directories dialog box.
Choose either full synchronization or define detailed settings for different and missing
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files.
Optionally, adapt the default synchronization settings or change the synchronization
action for individual files.
To run the directory synchronization, click the Start button. If you choose to not run the
synchronization and abort the synchronization settings you defined in the Synchronize
directories dialog box, click the Cancel button to return to the Directory Comparison
window from where you opened the Synchronize directories dialog box.

After you have clicked the Start button, DiffDog displays a summary where the different actions
are listed that will be performed during the synchronization.

You can click on OK to commit the changes or cancel the synchronization process.
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Navigating Differences
When the results of a comparison are first displayed it is always the first difference that is the
current difference. You can navigate through the differences by selecting other differences to be
the current difference or move the selection of the current difference by using the following
navigation commands in the Diff and Merge menu and toolbar:
Next Difference (Alt+Down): Selects the next difference as the current difference.
Previous Difference (Alt+Up): Selects the previous difference as the current difference.
Last Difference (Alt+End): Selects the last difference in the document as the current
difference.
First Difference (Alt+Home): Selects the first difference in the document as the current
difference.
Display Current Difference (Ctrl+Enter): Scrolls through the document to display the
current difference. This command is useful if you have scrolled to some point that causes
the current difference to be outside the display area (document pane).
Make Current Difference (Alt+Enter): Makes the selected difference the current
difference, and sets it as the difference from which to navigate. The Make Current
Difference command is useful if you wish to jump directly to a particular difference and
navigate from there.
If the icons described above are not displayed in your toolbar, you can include them by checking
the Diff and Merge option in the Toolbars tab of the Customize dialog box.
Please note: The navigation commands move the selection of the current difference in both
documents. If you wish to edit highlighted text, you must place the cursor in the highlighted text
(in the appropriate document).

Current difference and editing
If, in a File Comparison window, you start typing into the document and the Compare While
Editing
toggle in the Diff and Merge menu is off, all difference highlighting disappears in
both documents. If the Compare While Editing toggle is on, then if you type in something that
results in a difference it is highlighted as the current difference; if you make a modification that
removes a difference, the difference immediately following the cursor position is highlighted as the
current difference.
To make a difference the current difference:
1.

Place the cursor in the required difference (which could be anywhere in the document) or
navigate to it using the Next Difference
commands listed above.

2.

or Previous Difference

navigation

Select the menu option Diff and Merge | Make Current Difference or press Alt+Enter
or select the corresponding toolbar icon
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Merging Differences
After running a file or directory comparison in a comparison window, you can merge differences
that exist between the directories/files in the two panes.
In File Comparison windows,a difference (that is, a text fragment for which there is no, or no
identical, corresponding text fragment in the compared file) can be copied over from one file to the
corresponding location in the other file.
In Directory Comparison windows, the selected non-equal file (a file for which no, or no equal,
corresponding file exists in the compared directory) can be copied from one directory to the other
directory.
You use the following commands to merge a difference:
Copy from Left to Right (Alt+Right)
For the selected difference in a file comparison, copies text from the document in the left
pane to the document in the right pane.
For the selected non-equal file in a directory comparison, copies the file from the
(directory in the) left pane to the (directory in the) right pane.
Copy from Right to Left (Alt+Left)
For the selected difference in a file comparison, copies text from the document in the
right pane to the document in the left pane.
For the selected non-equal file in a directory comparison, copies the file from the
(directory in the) right pane to the (directory in the) left pane.
In file comparisons, the source difference is copied in its entirety (i.e., the entire unit highlighted in
the current difference background color overwrites the entire difference in the target document).
Merged differences in file comparisons can be shown in a different background color. This setting
is made in the File Comparison tab of the DiffDog Options dialog box.
To merge a difference:
1.

Place the cursor in the required difference (which could be anywhere in the document) or
navigate to it using the Next Difference
commands listed above.

2.

navigation

Select the menu option Diff and Merge | Make Current Difference or press Alt+Enter
or select the corresponding toolbar icon

3.

or Previous Difference

from the Diff and Merge toolbar.

Do one of the following:
Select the menu option Diff and Merge | Copy from Left to Right or click the
corresponding toolbar icon
pane to the right pane.

or press Alt+Right if you want to copy from the left

Select the menu option Diff and Merge | Copy from Right to Left or click the
corresponding toolbar icon
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Exporting Differences
For both file and directory comparisons, the differences can be exported to file. Differences can be
exported either in XML
or in text
format; the available format depends on the comparison
mode, according to the following table:

File comparison

n.a.

n.a.

Directory comparison

To export differences to file:
1.
2.
3.

Run a file or directory comparison.
On the File menu, click Export differences.
Enter a destination file name, select the desired format (XML or text), and click Save.

Be aware that, in case of XML comparisons, the Export Differences command is available only if
the XML comparison options are set as follows from Tools | Comparison Options | XML tab:
1.
2.

The Detailed differencing check box must be selected.
The Ignore node depth check box must not be selected.
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Saving and Loading Comparisons
The settings selected for a file or directory comparison can be saved in a .filedif or .dirdif
file, respectively. The .filedif extension is used for file and MS Word comparisons. The
.dirdif contains Word options only if saved from the Enterprise edition. When a .filedif or
.dirdif file is opened with DiffDog, the GUI loads the two objects to be compared using the
settings saved in the .filedif or .dirdif file. This feature is useful if you wish to repeat a
comparison of two files or two folders at a later time with the same settings as the current
settings for that comparison.

Saving .filedif and .dirdif files
To save the settings of the comparison, select the command File | Save As. Select the
appropriate filetype (.filedif or .dirdif), enter the filename you want and click Save. The file
is saved to the specified location. DiffDog will be the default editor of these file extensions; this will
have been set by the installer at the time of installation.

Opening .filedif and .dirdif files
To open a comparison file (.filedif or .dirdif), select the command File | Open
Comparison File, browse for the comparison file, and click Open. You can also drag-and-drop
the file from Windows Explorer into DiffDog. Full URL support (that is, local, http, and ftp) is
available.
A .dirdif file can be opened in any edition, irrespective of which edition the file was saved from.
(MS Word options can only be saved in the Enterprise edition.) If you are using a Professional
Edition and the .dirdif file contains Word options (which are not supported in the Professional
edition), then an error message appears on opening the file.

Command line support
You can also use the command line to open one comparison file at a time, for example:
DiffDog.exe C:\test1.filedif
DiffDog.exe C:\test*.filedif
DiffDog.exe C:\test.*dif

The asterisk ( * ) wildcard is allowed when opening .filedif or .dirdif files.

Running Comparisons with DiffDog Server
If you have licensed DiffDog Server, you can run .filedif or .dirdif comparisons at the command line
with DiffDog Server. To do this, supply the .filedif or .dirdif file path as argument to the import
command. If you need to redirect the comparison output to a file in XML or text format, take the
following steps:
1.
2.
3.

Open an existing .dirdif or .filedif file (or create a new comparison) in DiffDog.
On the Tools menu, click Comparison Document Options.
Do one of the following:
a. To use no redirection to a file, click No Export (this is the default option).
b. To redirect the report to a text file, click Text file, and then enter the path in the

Altova DiffDog 2018

© 2018 Altova Gmb H

Saving and Loading Comparisons

89

adjacent text box.
To redirect the report to an XML file, click XML file, and then enter the path in the
adjacent text box.
On the File menu, click Save As, and then save the comparison as .filedif (or .dirdif, if
applicable).
c.

4.

For more information, refer to DiffDog Server documentation (https://www.altova.com/
documentation).
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Comparison Management Options
The Diff and Merge menu includes a series of commands that are used to customize the file and
directory comparisons and can be summed up as comparison management options. Apart from
the option to explicitly start a comparison (see below), options to automate certain comparison
functions as well as to facilitate the selection of recently compared pairs are available.

Starting a comparison
The Start Comparison command in the Diff and Merge menu applies to File Comparison as
well as Directory Comparison windows and is used to explicitly start a comparison at any time.
Please note that a comparison starts automatically and this command is thus not needed if the
Autostart Comparison or Compare while Editing comparison management options are toggled on.
To explicitly start a comparison:
Select the menu option Diff and Merge | Start Comparison or press F5. Alternatively,
you can also click the corresponding toolbar button
in the Diff and Merge toolbar or
right-click the tab of a comparison window and select the Start Comparison command
from the context menu that appears.
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Automatic Comparison Functions
DiffDog provides options that automatically start a comparison when files are loaded or edited. In
addition, you can display the comparison options each time before a comparison is actually
started. Note that all of these options are toggle commands.

Autostart Comparison
If the Autostart Comparison option is toggled on, then a comparison is automatically made when
files or directories are loaded into a comparison window. If this option is toggled off, then a
comparison (file or directory) must be explicitly started.
To autostart comparisons:
Activate the menu option Diff and Merge | Autostart Comparison or activate the
corresponding toolbar icon

in the Diff and Merge toolbar.

Compare while Editing
A toggle to compare or not compare documents in File Comparison windows while editing. If
toggled on, differences are highlighted as you edit. If toggled off, highlighting of differences is
turned off in both documents as soon as you start typing in either document; to highlight
differences after editing, you must run a comparison.
To compare files while editing:
Activate the menu option Diff and Merge | Compare while Editing or activate the
corresponding toolbar icon

in the Diff and Merge toolbar.

Show Options Before Comparison
This command is toggled either on or off for individual comparison windows. When toggled on for a
comparison window, the Comparison Options dialog box is displayed each time a comparison is
made in that window. Note that the Comparison Options dialog box is not displayed before
comparisons made dynamically by DiffDog while you edit a document.
To show the options before comparison:
Activate the menu option Diff and Merge | Show Options Before Comparison or
activate the corresponding toolbar icon

© 2018 Altova Gmb H

in the Diff and Merge toolbar.

Altova DiffDog 2018

94

9.2

Comparison Management Options

Recently Compared Pairs

Recently Compared Pairs
If, (i) a file or directory you select for comparison has previously been compared with another file
or directory, respectively, and (ii) the Support Recently Compared Pairs option in the Diff and
Merge menu has been toggled on, then the Recently Compared Pairs dialog box (shown below)
appears. This dialog box contains a list of the five files or directories with which the file or directory
being opened has most recently been compared.

If you wish to compare the file or directory being opened with one of the files or directories listed in
this dialog box, select the item from the list in the dialog box and click OK. This causes both files
or directories to be opened, one in each pane. If you do not wish to select any of the items listed
in the dialog, click Cancel. This causes the file or directory to be opened alone; you now have to
select the file or directory with which you wish to compare it in the second pane.
Note: Clicking Cancel causes the selected file or directory to open in one pane without opening
any previously compared file or directory in the other pane. Clicking Cancel does not stop the
selected file or directory from being opened. If you wish not to have the Recently Compared
Pairs dialog box appear each time you open a document, then toggle the Support Recently
Compared Pairs option off.
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10 DiffDog Options
The Tools | DiffDog Options command enables you to define global application settings. These
settings are specified in a dialog box and saved in the registry. They apply to all current and future
document windows. The Apply button in the DiffDog Options dialog box displays the changes in
the currently open documents and fixes the current settings. The changes are seen immediately
in the background windows.
Each page of the DiffDog Options dialog box is described in detail in this section.
To change DiffDog settings:
1.

2.

Select Tools | DiffDog Options... or select the DiffDog Options
and Merge toolbar.
The DiffDog Options dialog box appears.
Select the tabs for the following options:

button in the Diff

Application
File Comparison
Directory Comparison
File Types
Network Proxy Settings
3.

Make the desired changes and click OK.
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10.1 Application
In the Application tab of the DiffDog Options dialog box, you define the startup options of the
application.

Startup
Three radio buttons are available to define whether DiffDog starts up with an empty File
Comparison window, an empty Directory Comparison window, or no comparison window.
If the Allow multiple instances check box is deactivated, starting DiffDog when an instance of
DiffDog is already running causes a new comparison window (file, directory, or empty) to open in
the already running instance of DiffDog.
The Show Program Logo option—if checked—displays the splash screen (logo) when DiffDog
starts.

Windows Explorer Integration
If the Add "Compare with Altova DiffDog" entry to the Windows Explorer context menu check
box is activated, you can start a file or directory comparison directly from Windows Explorer by
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selecting the respective files or directories and choosing Compare with Altova DiffDog from the
context menu.

Encoding
You can select the encoding with which to open an XML file or non-XML files, respectively, where
the encoding cannot be detected.

Program logo
The Show Program Logo option—if checked—displays the splash screen (logo) when DiffDog
starts. The Show on print becomes enabled and can be switched off after you have registered your
application. If this option is checked, the program logo is printed with the active document or
directory-comparison result, when this is printed.
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10.2 File Comparison
The File comparison tab enables you to set preferences for file comparisons. These options
range from display attributes to file actions, and apply to all open and subsequently opened file
comparisons.

Backup files
This option lets you configure whether the original file should be saved if you decide to save a
version of it that you have edited in DiffDog, and, in such cases, how the original file and edited file
should be named. The newly named files are created when you save an edited file. The following
options are available.
No backup: The original file is overwritten by the edited file, and the name of the original
file is retained.
Replace extension with .BAK: If the original file was called abc.xml, changes are written
to this file, and a copy of the original is saved as abc.bak.
Append .BAK to extension: If the original file was called abc.xml, changes are written to
this file, and a copy of the original is saved as abc.xml.bak.
Tip: The .BAK files can be set to be XML-conformant, and used for comparisons with other XML
files.
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If ZIP-conformant files change, DiffDog creates a backup for the individual files that have changed
inside the ZIP rather than a backup of the ZIP itself.

Automatic reload of changed files
If a file that is open in DiffDog has been changed by another application or another person, DiffDog
can reload the changed file, with or without prompting you to reload.

Editing
You can make a difference in the compared documents the current difference by clicking in it if
the Clicking a difference makes it the current difference check box is activated.
The properties of the display font can be freely chosen. Clicking the Font button opens the Font
dialog box for this purpose.

Colors
You can choose different background colors for highlighting differences in compared documents,
including:
the current difference (that is, the difference that is currently in focus, or selected)
merged differences (that is, all merged differences that have not been saved as yet)
the current merged difference (a merged difference that is currently selected)
To reset the default colors, click the Default colors button.

Pretty-Print
The Pretty-Print XML files when loading option automatically creates a more user-friendly
display when XML files that are originally delivered in a continuous stream without line breaks are
loaded into File Comparison windows.
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10.3 Directory Comparison
The Directory comparison tab enables you to create filters that determine what files will be
considered in directory comparisons

Note: After exiting this dialog box by clicking OK, you still have to select the required filter in the
Directory Comparison window. Clicking OK does not select the filter for use; it saves the changes
and exits the dialog box.

File/Directory filters
Filters are available for selection in the toolbar of the Directory Comparison window and in the
Open Comparison dialog box if the Compare directories option has been selected.
The File/Directory filters group box contains several buttons for defining, organizing, and deleting
the filters:
Opens the Edit Filter dialog for the selected filter, where you can change the filter
definition.
Opens the Edit Filter dialog, where you can create a new filter. When the definition is
completed, the filter is added to the list of available filters below the filter that has been
selected when the button has been clicked.
© 2018 Altova Gmb H

Altova DiffDog 2018

102

DiffDog Options

Directory Comparison

Moves the selected filter one position down in the list of filters.
Moves the selected filter one position up in the list of filters.
Creates a copy of the selected filter.
Pastes the copy of a filter below the selected filter.
Deletes the selected filter.

Default file/directory filters
This group box contains a drop-down list with the available default filters. Select a filter and click
Create to open the Edit Filter dialog box, where you can create a new filter based on the
definition of the selected default. Edit name and filter definition as required and click OK to add a
new filter to the list of available filters in the File/Directory filters group box.

Modification Alerts
If the Enable alerts for modifications inside directories check box is activated, DiffDog
displays a warning message when the content of the displayed folders is changed outside of
DiffDog. You can then decide whether or not you want to update the display.

Quick comparison
In this group box, you can define whether size only, or size and modification date should be
considered during quick comparison. When Size and modification time is selected. you can
also activate the Allow time difference of exactly 1 hour check box. A time difference of
exactly one hour may occur shortly after the shift to, or from, daylight saving time when the
system time is changed automatically. Activating the Allow time difference of exactly 1 hour
check box will prevent such files from being displayed as different.

Confirm merge operation
You can define whether or not a warning message should be displayed before files are deleted,
copied, or replaced during directory merge operations.

If you activate the Don't show this dialog again! in this dialog box, the corresponding option is
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automatically deactivated in the DiffDog Options dialog box.

10.3.1

Defining a Filter
The Edit Filter dialog provides several options to restrict the directory comparison:
Consider only files of a certain type
Consider only specific directories
Ignore certain files or directories
Compare files or directories with certain attributes
Define a date range for files/directories to be compared
Restrict files to a certain file size

Note that if a file type is included in both the Include only files and Ignore files field, then that
file type is ignored in a directory comparison.
For Directory Comparison windows that were opened before a new filter is selected, you must
reload both directories so that the new filters are applied to these comparison windows.
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Modification date
In the Modification date group box, you can enter a From and/or a Till date to define a date range
for directory comparison. Only files within that particular date range will be considered when the
directories are compared. To include all files from or until a particular date, select only the
corresponding check box (From or Till, respectively) and leave the second check box
unchecked. After you select the From or Till check box, you can either type or select the part of
the date that you want to change.
To define a filter for directory comparison:
1.

Select the menu option Tools | DiffDog Options and change to the Directory
Comparison tab, or click the Edit Filter
button in the toolbar of a File Comparison
window to open the DiffDog Options dialog.

2.
3.

4.

5.

6.

7.
8.

9.

Click the
button to open the Edit Filter dialog.
In the Edit Filter dialog, enter a descriptive name in the Filter name field.
By default, "*.*" is displayed in the Include only files fields and ''*" is displayed in the
Include only directories fields. If you don't change this settings, files of all types and in all
directories will be compared.
To restrict the comparison to certain file types, enter the file extension in the Include
only files field. To exclude file types from comparison, enter the file extension in the
Ignore files field. Note that file types are listed in the form *.ext, and that the delimiter
between file types in a filter is the semi-colon (;).
To include or ignore specific sub-folders of a directory during comparison, enter the name
of the folder(s) in the Include only directories field or the Ignore directories field,
respectively. You can also use the wildcard character * to enter only parts of folder
names. Note that the delimiter between individual folder names in a filter is the semicolon (;).
To include files or directories that have certain attributes applied, activate the respective
check box(es) in the File/Directory attributes group box. Files or directories with
unchecked attributes will not be shown in the Directory Comparison window. Note that
hidden files in hidden directories will not be shown if the Hidden check box is activated
for files but deactivated for directories.
Activate the From and/or Till check boxes in the Modification date group box, if you want
to restrict the comparison to a certain date range.
Activate the From and/or Till check boxes in the File size group box, if you want to
restrict the comparison to files of a certain size. Enter a number and select the
appropriate unit from the drop-down list.
Click OK to save the changes.
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10.4 File Types
In the File types tab, you set the default comparison mode of various file types. File types are
identified by their extension (.asp, .biz, etc.), and the comparison mode can be XML, text,
binary, or ZIP-conformant.

File types
This pane is used to select the file extension for which the options in the group boxes Default
comparison mode and Use syntax coloring are defined. Please note that any changes that
you make in these two group boxes only apply to the file type currently selected in the File Types
pane.

Default file comparison mode
To assign a default comparison mode for a particular file type, in the Default file comparison mode
group box, choose one of the following radio buttons:
XML-conformant file
An instance of that file type is checked for XML conformance, and is treated as an XML
file if it is conformant. An XML-conformant file may be compared as XML or text.
Textual comparison
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Binary comparison
An instance of that file type is considered as binary file. A byte-by-byte comparison is
used in directory comparison. Files of this type will not be displayed in text view.
ZIP-conformant file
An instance of that file type is considered as a sub-directory in directory comparison. In
file comparison, files of this type are compared as binaries.
The comparison mode can be overridden for individual file comparisons by selecting the desired
comparison mode in the Diff and Merge menu. DiffDog detects binary files automatically.

Use syntax coloring
You can choose from among the following options for syntax coloring:
No syntax coloring
XML-conformant syntax coloring
Source code-conformant syntax coloring

Edit file type list
To add a new file type to the list in the File types pane, click the Add New File Extension
button. To delete a file type from the list, select the file extension in the list and then click the
Delete Selected File Extension button.
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10.5 Network Proxy Settings
The Network Proxy section enables you to configure custom proxy settings. These settings
affect how the application connects to the Internet (for XML validation purposes, for example). By
default, the application uses the system's proxy settings, so you should not need to change the
proxy settings in most cases. If necessary, however, you can set an alternative network proxy
using the options below.
Note:

The network proxy settings are shared between all Altova MissionKit applications.
Consequently, if you change the settings in one application, they will automatically affect
all other applications.

Use system proxy settings
Uses the Internet Explorer (IE) settings configurable via the system proxy settings. It also queries
the settings configured with netsh.exe winhttp.

Automatic proxy configuration
The following options are provided:
Auto-detect settings: Looks up a WPAD script (http://wpad.LOCALDOMAIN/wpad.dat)
via DHCP or DNS, and uses this script for proxy setup.
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Script URL: Specify an HTTP URL to a proxy-auto-configuration (.pac) script that is to be
used for proxy setup.
Reload: Resets and reloads the current auto-proxy-configuration. This action requires
Windows 8 or newer, and may need up to 30s to take effect.

Manual proxy configuration
Manually specify the fully qualified host name and port for the proxies of the respective protocols.
A supported scheme may be included in the host name (for example: http://hostname). It is not
required that the scheme is the same as the respective protocol if the proxy supports the
scheme.
The following options are provided:
Use this proxy for all protocols: Uses the host name and port of the HTTP Proxy for all
protocols.
No Proxy for: A semi-colon (;) separated list of fully qualified host names, domain names,
or IP addresses for hosts that should be used without a proxy. IP addresses may not be
truncated and IPv6 addresses have to be enclosed by square brackets (for example:
[2606:2800:220:1:248:1893:25c8:1946]). Domain names must start with a leading
dot (for example: .example.com).
Do not use the proxy server for local addresses: If checked, adds <local> to the No
Proxy for list. If this option is selected, then the following will not use the proxy: (i)
127.0.0.1, (ii) [::1], (iii) all host names not containing a dot character (.).

Current proxy settings
Provides a verbose log of the proxy detection. It can be refreshed with the Refresh button to the
right of the Test URL field (for example, when changing the test URL, or when the proxy settings
have been changed).
Test URL: A test URL can be used to see which proxy is used for that specific URL. No I/
O is done with this URL. This field must not be empty if proxy-auto-configuration is used
(either through Use system proxy settings or Authomatic proxy configuration).
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11 User Reference
The User Reference section contains a complete description of all DiffDog menu commands.
We've tried to make this user manual as comprehensive as possible. If, however, you have
questions which are not covered in the User Reference or other parts of this documentation,
please look up the FAQs and Discussion Forums on the Altova website. If you are still not able to
have your problem satisfactorily addressed, please do not hesitate to contact us through the
Support Center on the Altova website.
Note that in the File and Edit menus, all standard Windows commands are supported, as well as
DiffDog-related commands
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11.1 Toolbar icons
Icons in the toolbar are shortcuts for various commands, most of which are also available as menu
commands. You can toggle the display of any group of icons in the toolbar on or off using the
Toolbars tab of the Customize dialog (Tools | Customize). In the GUI, you can move a toolbar by
dragging its handle to the desired location.
The available toolbars are depicted below. See the respective chapters in the Reference section
for a description of the commands.
The Standard toolbar contains shortcuts for file commands and common editing commands that
occur in the File, Edit, and XML menus.

The Comparison Mode toolbar enables you to select the comparison mode for files and
directories. This group of commands is available in the Diff and Merge menu.

The Diff and Merge toolbar enables you to start comparisons, navigate through differences
between files, merge differences, and set application and comparison options. All these
commands are available in the Diff and Merge menu and in the Tools menu.

The Directory Content toolbar enables you to configure the display of Directory Comparison
windows. Note that—except for the directory synchronization commands, which are included in
the Diff and Merge menu—none of these commands are available as menu commands (see
chapters "Configuring the View" and "Running a Directory Comparison" in the section "Comparing
Directories" for a description) . Each of these commands applies to the active directory
comparison only.

The Grid toolbar is enabled in Grid View in File Comparison windows, and most of these
commands are available in the Grid View menu. With the Grid Group commands, you can make
structural editing changes and modify the Grid View of your XML document. Grid View is not
available for non-XML or non-well-formed documents; that is, for the Grid View of a document to be
displayed, the document must be an XML document and be well-formed.

The following icons are not included in the Grid View menu:
Expand all selected: In Grid View, this command expands one or more selected nodes
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in Grid View.
Collapse all selected: In Grid View, this command collapses the selected nodes.
Fully expand all selected: In Grid View, this command expands all selected nodes and
their descendant nodes.
Collapse unselected: In Grid View, this command collapses all selected nodes and
their descendant nodes.
Optimal widths: In Grid View, this command sets columns to optimal widths.
The Text toolbar enables you to configure the display and navigation features of Text View. Some
of these commands apply to the selected file only (that is, the file in which the cursor is). Other
commands apply to all open files and subsequently opened files. All these commands are
available as Text View menu commands.

Icons in the Grid Edit Group are used for editing in Grid View. These commands are fully
described in the Grid View Menu section. Please note that this toolbar is deactivated by default,
you have to activate the respective check box in the Toolbars tab of the Tools | Customize dialog
box to view it.
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11.2 File Menu
The File menu contains all commands relevant to manipulating files, in the order common to most
Windows software products.

In addition to the standard Open, Save, Print, Print Setup, and Exit commands, DiffDog offers a
range of application-specific commands. Note that each of the two panes also has pane-specific
icons located near the top of each pane to open and refresh the file/directory in that pane and (for
file comparisons) to save the file in that pane.

11.2.1

Compare Files

The Compare Files command opens a new empty window with two empty panes for file
comparison. The two files to be compared must be opened subsequently in the panes of the
comparison window. See Running a File Comparison.

11.2.2

Compare Directories

The Compare Directories command opens a new empty window for directory comparison. The
two directories to be compared must be opened separately in each pane.
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Open...
Ctrl+O
The Open... command enables you to open a File Comparison window or Directory Comparison
window with the files or directories already selected. This is in contrast with the Compare Files
and Compare Directories commands, which open empty comparison windows.
Note that the layout of the dialog box changes depending on whether you choose Compare
files or Compare directories in the Mode group box.

11.2.4

Close
The Close command closes the active comparison window. If you have unsaved changes in either
document of a file comparison being closed, the Save files dialog box appears (screenshot
below). Both files in the file comparison are displayed. If a file contains unsaved changes, it is
checked.

To close a comparison window:
1.
2.
3.

Click the tab of the comparison window you want to close.
Select the menu option File | Close or click the Close
button in the upper right corner
of the comparison window.
If a file contains unsaved changes, the Save files dialog box appears. Do one of the
following:
If you wish to save changes in a file, make sure that its check box is selected and
click Save selected.
Click Discard changes to not save changes.
Click Cancel to not close the comparison window.
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Close All
The Close all command closes all open comparison windows. If a document in a file comparison
contains unsaved changes, the Save files dialog box (see screenshot above) appears for that file
comparison. Directory comparisons are closed without any prompt.
If more than one file comparison contains document/s with unsaved changes, a Save files dialog
box is displayed for each File Comparison window before the window is closed.

11.2.6

Save
Ctrl+S
The Save command is available only for file comparisons, and it pops up the Save files dialog
box (see screenshot above). Both files are displayed in the dialog. If a file contains unsaved
changes, the file is listed with a check mark.
Note: Clicking the Save

icon of an individual pane in a File Comparison window causes

the document in that pane to be saved without further prompting. The Save As
you to save the document in that pane with a different filename.

11.2.7

icon enables

Save As
The Save As... command pops up the familiar Windows Save As dialog box, in which you enter
the name and location of the file you wish to save the active file as.

11.2.8

Export Differences...
The Export differences... command allows you to export differences to a file. This menu option
is available for both file and directory comparisons.

11.2.9

Print...
Ctrl+P
The Print... command pops up the Windows Print dialog box, in which you enter details about
the print job. Note that this command prints the active document, that is, the document in which
the cursor is when the command is invoked.
Note: You can print the active document from both Text View and Grid View. The output will be a
printout of the selected view.
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11.2.10 Print Preview

The Print Preview command displays a preview of how the active document will be printed.

11.2.11 Print Setup...
The Print Setup... command pops up the Windows Print Setup dialog, in which you can change
printer settings for the print job and other printer properties. Settings include page orientation,
paper size, and paper source. After you exit the Print Setup dialog, you must still use the Print
command to print a document.

11.2.12 Exit
This command exits the DiffDog application. If documents in one or more File Comparison
windows contain unsaved changes, DiffDog pops up the Save files dialog box separately for each
file comparison containing an unsaved change. After you have answered the prompts, DiffDog
closes.
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11.3 Edit Menu
In DiffDog, you can edit documents displayed in a File Comparison window. You edit a document
either by typing directly into it, and/or by using keyboard shortcuts or commands in the Edit
menu.

The commands in the Edit menu include standard editing functions, such as Undo, Cut, Copy,
Paste, and a powerful Find and Replace function. These commands are described in the subsections of this section.
Please note that editing commands are document-specific and that Edit menu commands are not
available when a directory comparison is active.

11.3.1

Undo
Alt+Backspace, Ctrl+Z
The Undo command enables you to undo an unlimited number of previous actions for each
document separately. To undo previous actions in any document, place the cursor in that
document and select the Undo command. You can switch among documents in multiple open file
comparisons. In each document, the Undos will continue from the point where it was last left.
Please consider the following when using the Undo and Redo commands:
The Undo and Redo commands also undo and redo merged differences an unlimited
number of times.
It is important to place the cursor in the document that has been changed. For example,
if you merge a difference from the Left Pane to the Right Pane, then the Undo for this
action will only be available if the cursor is placed in the Right Pane (because this pane
contains the document that has been changed).
The Undo and Redo history is lost when the view is switched from Text View to Grid
View, or vice versa.
The Edit menu and the Undo and Redo commands are not available in Directory
Comparison windows.
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Redo
Ctrl+Y
The Redo command reverses a previous Undo command, and can be executed as many times
as an Undo was performed. Like the Undo command, the Redo command is also documentspecific, and you can switch among documents.
Note that the Edit menu and, therefore, this command are not available in Directory Comparison
windows.

11.3.3

Cut
Shift+Delete, Ctrl+X
The Cut command copies the selected text to the clipboard and deletes it from its present
location.
Note that the Edit menu and, therefore, this command are not available in Directory Comparison
windows.

11.3.4

Copy
Ctrl+C
The Copy command copies the selected text to the clipboard. This can be used to duplicate data
within DiffDog or to move data to another application.
Note that the Edit menu and, therefore, this command are not available in Directory Comparison
windows.

11.3.5

Paste
Ctrl+V
The Paste command inserts the contents of the clipboard at the current cursor position of any
document you make active in DiffDog. You can also paste text from the clipboard into any other
document in an application that supports pasting from the clipboard.
Note that the Edit menu and, therefore, this command are not available in Directory Comparison
windows.
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Delete
Delete
The Delete command enables you to delete a selection in the document.
Note that the Edit menu and, therefore, this command are not available in Directory Comparison
windows.

11.3.7

Find...
Ctrl+F
The Find... command pops up the Find dialog box, in which you can specify the string you want
to find and other options for the search.
Note that the Edit menu and, therefore, this command are not available in Directory Comparison
windows.

11.3.8

Find next
F3
The Find next command repeats the last Find... command to search for the next occurrence of
the requested text. Clicking this command when the Find dialog box is open, closes the Find
dialog box before taking you to the next occurrence of the search string.
Note that the Edit menu and, therefore, this command are not available in Directory Comparison
windows.

11.3.9

Replace...
Ctrl+H
The Replace... command enables you to find and replace one text string with another text string.
It features the same options as the Find... command. You can replace each item individually or
you can use the Replace All button to perform a global search-and-replace operation.
Note that the Edit menu and, therefore, this command are not available in Directory Comparison
windows.
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11.4 View Menu
The View menu contains the following commands:
Text View
Grid View
Toolbars
Status Bar
Synchronized Scrolling
Go to line/char

11.4.1

Text View
The Text View command is available in File Comparison windows (not Directory Comparison
windows), and switches both files of the active File Comparison window to Text View. Note that
both files are always displayed in the same view. To switch the view, you can also use the Text
View tab of either pane; the tabs are located at the bottom of each pane.

11.4.2

Grid View
The Grid View command is available in File Comparison windows (not Directory Comparison
windows), and switches both files of the active File Comparison window to Grid View. Note that
both files are always displayed in the same view. To switch the view, you can also use the Grid
View tab of either pane; the tabs are located at the bottom of each pane.

11.4.3

Toolbars
The Toolbars menu item contains a submenu with commands that show or hide the respective
application toolbars.
Toolbar settings take effect depending on the current comparison mode. For example, if toolbar
settings are made with a File Comparison window open, the settings apply to all File Comparison
windows that are currently open and that will be opened subsequently. You can restore all
toolbars to their default state by running the menu command Tools | Restore Toolbars and
Windows.
The Customize submenu item is a shortcut for the Tools | Customize... command.

11.4.4

Status Bar
The Status Bar, located at the bottom of the DiffDog application window, displays the following
application-level information:
A description of menu command and toolbar icon actions; displayed when the mouse
cursor is placed over the command or icon. This information is on the left side in the
Status Bar.
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Position of the cursor in a document, in terms of line number and character number
(lower-right corner)
Status of the Caps Lock, Num Lock and Scroll Lock keys (lower-right corner)
If you are using the 64-bit version of DiffDog, this is indicated in the status bar with the
suffix (x64) after the application name. There is no suffix for the 32-bit version.
You can toggle the Status Bar on and off using the Status Bar command in both File Comparison
and Directory Comparison windows.
Note: Do not confuse the Application Status Bar described here with the File Comparison and
Directory Comparison Status Bars, which are located at the bottom of Comparison Windows and
contain information about that comparison. Comparison Window status bars are described in the
DiffDog Interface section.

11.4.5

Synchronized Scrolling
The Synchronized Scrolling command opens a sub-menu, where you can set this option
separately for horizontal and vertical scrolling.

Synchronized scrolling is available in File Comparison windows. If documents extend over a
horizontal or vertical length greater than the size of its containing pane, horizontal and vertical
scrollbars, respectively, appear at the bottom and right of the pane, respectively. When
synchronized scrolling is enabled, both documents can be scrolled simultaneously so that
corresponding sections of the two documents are displayed simultaneously.
If you scroll through one document (by moving the scrollbar, clicking the scroll arrows, or using
the mouse wheel) when synchronized scrolling is toggled on, the document in the other pane will
also scroll (horizontally or vertically) so that the corresponding part of the document is displayed.
Please note that synchronized scrolling is possible only after a file comparison has been carried
out (since the correspondence of sections in the two documents can only be determined after a
comparison is made).
Settings for synchronized scrolling apply to the application as a whole, and take effect
immediately for all open File Comparison windows and subsequently opened File Comparison
windows.

11.4.6

Go to line/char
Ctrl+G
The Go to line/char feature is available in File Comparison windows only, and enables you to go
to a particular location in the active document using line and character coordinates. The command
pops up the Go to text line/character dialog (screenshot below).
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Enter the required line and character numbers in the respective text boxes, and click OK. This
positions the cursor at the specified location.
Note: In Grid View, the Go to line/char feature highlights the grid cell closest to the line or
character number you enter.
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11.5 Text View Menu
The Text View menu contains commands that apply to the Text View display of documents in
File Comparison windows. They enable you to customize the display of documents.

11.5.1

Word Wrap

The Word Wrap command enables or disables word wrapping in Text View.

11.5.2

Pretty-Print XML Text

The Pretty-Print XML Text command reformats the active XML document in Text View to give a
structured display of the document. Each child node is offset from its parent by four space
characters.
Note: The Pretty-Print XML Text command is not a toggle command. Once the command is
executed, the pretty-printed format cannot be undone by clicking the Pretty-Print XML Text
command again. To undo the pretty-printed format, you must use the Undo (Ctrl+Z or Alt
+Backspace) command.

11.5.3

Insert/Remove Bookmark

The Insert/Remove Bookmark command is available in Text View only. It inserts a bookmark at
the current cursor position, or removes the bookmark if the cursor is in a line that has been
bookmarked previously.
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Bookmarked lines are displayed in one of two ways: If the bookmarks margin has been enabled,
then a solid cyan-colored ellipse appears to the left of the text in the bookmark margin. If the
bookmarks margin has not been enabled, then the complete line containing the cursor is
highlighted in cyan.
Tip: You can assign a keyboard shortcut for this command in the Keyboard tab of the Customize
dialog box.

11.5.4

Go to Next Bookmark

The Go to Next Bookmark command is available in Text View only. It places the text cursor at
the beginning of the next bookmarked line.
Tip: You can assign a keyboard shortcut for this command in the Keyboard tab of the Customize
dialog box.

11.5.5

Go to Previous Bookmark

The Go to Previous Bookmark command is available in Text View only. It places the text cursor
at the beginning of the previous bookmarked line.
Tip: You can assign a keyboard shortcut for this command in the Keyboard tab of the Customize
dialog box.

11.5.6

Remove All Bookmarks

The Remove All Bookmarks command is available in Text View only. It removes all currently
defined bookmarks in the active document. Note that the Undo command does not undo the
effects of this command.
Tip: You can assign a keyboard shortcut for this command in the Keyboard tab of the Customize
dialog box.

11.5.7

Toggle All Folds

The Toggle All Folds command toggles the active document between two states: (i) all nodes
expanded, and (ii) all nodes collapsed.
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Text View Settings
The Text View Settings command opens the Text View Settings dialog box where you can
define settings for the display of line number, bookmark, and source folding margins, specify the
tab size, and define which visual aids are available in Text View.
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11.6 Grid View Menu
The Grid View Menu contains commands for working with documents in the Grid View of File
Comparison windows.

These commands are not available in Text View.

11.6.1

Insert
Placing the cursor over the Insert command pops up a sub-menu which contains the items that
can be inserted. The submenu items of the Insert command are enabled only in Grid View. Items
that cannot be inserted for the current selection are grayed out.

The commands of the Insert sub-menu can be used to insert (i) the XML declaration and node
types (Attribute, Element, Text, CDATA, Comment, Processing Instruction) in XML documents,
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(ii) DOCTYPE declarations and external DTD declarations in XML documents, and (iii) DTD
declarations (ELEMENT, ATTLIST, ENTITY, and NOTATION) in DTD documents and internal DTD
declarations of XML documents.

11.6.1.1

Insert | Attribute

The Insert | Attribute command is available in Grid View only, and inserts a new attribute before
the selected item. Sometimes, an inserted attribute may appear a few lines before the current
item in Grid View. This is because attributes immediately follow their parent element in Grid View
and precede all child elements of that parent element.

11.6.1.2

Insert | Element

The Insert | Element command is available in Grid View only, and inserts a new element before
the selected item. If the current selection is an attribute, the new element is inserted before the
first child element of the attribute's parent element.

11.6.1.3

Insert | Text

The Insert | Text command is available in Grid View only, and inserts a new text row before the
selected item. If the current selection is an attribute, the text row is inserted after the attribute and
before the first child element of the attribute's parent element.

11.6.1.4

Insert | CData

The Insert | CData command is available in Grid View only, and inserts a new CDATA block
before the selected item. If the current selection is an attribute, the CDATA block is inserted after
the attribute and before the first child element of the attribute's parent element.

11.6.1.5

Insert | Comment

The Insert | Comment command is available in Grid View only, and inserts a new comment
before the selected item. If the current selection is an attribute, the new comment row is inserted
after the attribute and before the first child element of the attribute's parent element.
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Insert | XML

The Insert | XML command is available in Grid View only, and inserts a row for the XML
declaration before the selected item. You must insert the child attributes of the XML declaration
and the values of this attribute. An XML declaration must look something like this:
<?xml version="1.0" encoding="UTF-8"?>
Note: Since an XML document may only contain one XML declaration at the very top of the file,
this command should only be used with the topmost row selected and if an XML declaration does
not already exist.

11.6.1.7

Insert | Processing Instruction

The Insert | Processing Instruction command is available in Grid View only, and inserts a new
processing instruction (PI) before the selected item. If the current selection is an attribute, the PI
is inserted after the attribute and before the first child element of the attribute's parent element.

11.6.1.8

Insert | DOCTYPE

The Insert | DOCTYPE command is available in the Grid View of an XML file when a top-level node
is selected. It appends a DOCTYPE declaration at the top of the XML document. You must enter
the name of the DOCTYPE, and this name must be the same as the name of the document
element.

After you have entered the name of the DOCTYPE, you can enter the declarations you wish to
use in the internal DTD subset.
Note: A DOCTYPE declaration may only appear between the XML declaration and the XML
document element.

11.6.1.9

Insert | ExternalID

The Insert | ExternalID command is available when a child item of the DOCTYPE declaration in
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an XML file is selected in Grid View. This command inserts a Grid View row for an external
identifier (PUBLIC or SYSTEM). You must enter the type of identifier and its value.

The Text View corresponding to the screenshot of the Grid View shown above looks like this:

Note: A row for ExternalID can be added as a child when the DOCTYPE item is selected, or it
can be inserted or appended when one of the child items of the DOCTYPE item is selected, for
example, the ELEMENT declaration name in the example above.
Referencing external resources
A DOCTYPE declaration in an XML file can contain a reference to an external resource containing
DTD declarations. This resource is referenced either through a public or system identifier. For
example:
<!DOCTYPE doc_element_name PUBLIC "publicID" "systemID">
<!DOCTYPE doc_element_name SYSTEM "systemID">
A system identifier is a URI that identifies the external resource. A public identifier is locationindependent and can be used to dereference the location of an external resource. For example, in
your <%SPY-GEN%> installation, URIs for popular DTDs and XML Schemas are listed in a
catalog file called MainCatalog.xml. A public identifier in an XML document can be used to
dereference a DTD listed in MainCatalog.xml.

11.6.1.10

Insert | ELEMENT

The Insert | ELEMENT command is available in Grid View only, for DTD documents or when an
item in the DOCTYPE declaration of an XML document is selected. It inserts an ELEMENT
declaration before the selected declaration.

11.6.1.11

Insert | ATTLIST

The Insert | ATTLIST command is available in Grid View only, for DTD documents or when an
item in the DOCTYPE declaration of an XML document is selected. It inserts an ATTLIST
declaration before the selected declaration.
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Insert | ENTITY

The Insert | ENTITY command is available in Grid View only, for DTD documents or when an item
in the DOCTYPE declaration of an XML document is selected. It inserts an ENTITY declaration
before the selected declaration.

11.6.1.13

Insert | NOTATION

The Insert | NOTATION command is available in Grid View only, for DTD documents or when an
item in the DOCTYPE declaration of an XML document is selected. It inserts a NOTATION
declaration before the selected declaration.

11.6.2

Append
Placing the cursor over the Append command pops up a submenu which contains the items that
can be inserted for a given selection. The submenu items of the Append command are enabled
only in Grid View. Items that cannot be inserted for the current selection are grayed out.
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The commands of the Append sub-menu can be used to append (i) the XML declaration and node
types (Attribute, Element, Text, CDATA, Comment, Processing Instruction) in XML documents,
(ii) DOCTYPE declarations and external DTD declarations in XML documents, and (iii) DTD
declarations (ELEMENT, ATTLIST, ENTITY, and NOTATION) in DTD documents and internal DTD
declarations of XML documents.

11.6.2.1

Append | Attribute

The Append | Attribute command is available in Grid View only, and appends a new attribute.

11.6.2.2

Append | Element

The Append | Element command is available in Grid View only, and appends an element node
after the last sibling element of the selected element. If an attribute node is selected, then the
element node is appended after the last child of the selected attribute's parent element.

11.6.2.3

Append | Text

The Append | Text command is available in Grid View only, and appends a text block after the
last sibling element of the selected element. If an attribute node is selected, then the text block is
appended after the last child of the selected attribute's parent element.

11.6.2.4

Append | CData

The Append | CData command is available in Grid View only, and appends a CDATA node after
the last sibling of any selected node other than an attribute node. If an attribute node is selected,
then the CDATA section is appended after the last child of the selected attribute's parent element.

11.6.2.5

Append | Comment

The Append | Comment command is available in Grid View only, and appends a comment node
after the last sibling of any selected node other than an attribute node. If an attribute node is
selected, then the comment node is appended after the last child of the selected attribute's parent
element.
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Append | XML

The Append | XML command is available in Grid View only, and inserts a row for the XML
declaration as the first item in a document. You must insert the child attributes of the XML
declaration and the values of this attribute. An XML declaration must look something like this:
<?xml version="1.0" encoding="UTF-8"?>
Note: Since an XML document may only contain one XML declaration at the very top of the file,
this command should only be used with the topmost row selected and if an XML declaration does
not already exist.

11.6.2.7

Append | Processing Instruction

The Append | Processing Instruction command is available in Grid View only, and appends a
processing instruction node after the last sibling of any selected node other than an attribute
node. If an attribute node is selected, then the processing instruction node is appended after the
last child of the selected attribute's parent element.

11.6.2.8

Append | DOCTYPE

The Append | DOCTYPE command is available in the Grid View of an XML file when a top-level
node is selected. It appends a DOCTYPE declaration at the top of the XML document. You must
enter the name of the DOCTYPE, and this name must be the same as the name of the document
element.

After you have entered the name of the DOCTYPE, you can enter the declarations you wish to
use in the internal DTD subset.
Note: A DOCTYPE declaration may only appear between the XML declaration and the XML
document element.

11.6.2.9

Append | ExternalID
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The Append | ExternalID command is available when a child item of the DOCTYPE declaration
in an XML file is selected in Grid View. This command inserts a Grid View row for an external
identifier (PUBLIC or SYSTEM). You must enter the type of identifier and its value.

The Text View corresponding to the screenshot of the Grid View shown above looks like this:

Note: A row for ExternalID can be added as a child when the DOCTYPE item is selected, or it
can be inserted or appended when one of the child items of the DOCTYPE item is selected, for
example, the ELEMENT declaration name in the example above.

11.6.2.10

Append | ELEMENT

The Append | ELEMENT command is available in Grid View only, for DTD documents or when an
item in the DOCTYPE declaration of an XML document is selected. It appends an ELEMENT
declaration to the list of declarations.

11.6.2.11

Append | ATTLIST

The Append | ATTLIST command is available in Grid View only, for DTD documents or when an
item in the DOCTYPE declaration of an XML document is selected. It appends an ATTLIST
declaration to the list of declarations.

11.6.2.12

Append | ENTITY

The Append | ENTITY command is available in Grid View only, for DTD documents or when an
item in the DOCTYPE declaration of an XML document is selected. It appends an ENTITY
declaration to the list of declarations.

11.6.2.13

Append | NOTATION

The Append | NOTATION command is available in Grid View only, for DTD documents or when
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an item in the DOCTYPE declaration of an XML document is selected. It appends a NOTATION
declaration to the list of declarations.

11.6.3

Add Child
Placing the cursor over the Add Child command pops up a submenu which contains the items
that can be inserted for a given selection. The submenu items of the Add Child command are
enabled only in Grid View. Items that cannot be inserted for the current selection are grayed out.

The commands of the Add Child sub-menu can be used to add child nodes for (i) the XML
declaration and node types (Attribute, Element, Text, CDATA, Comment, Processing Instruction)
in XML documents, (ii) DOCTYPE declarations and external DTD declarations in XML documents,
and (iii) DTD declarations (ELEMENT, ATTLIST, ENTITY, and NOTATION) in DTD documents and
internal DTD declarations of XML documents.

11.6.3.1

Add Child | Attribute

The Add Child | Attribute command is available in Grid View only and when an element node is
selected. It inserts a new attribute as a child of the selected element node.

11.6.3.2

Add Child | Element

The Add Child | Element command is available in Grid View only. It inserts a new element as a
child of the selected node.
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Add Child | Text

The Add Child | Text command is available in Grid View only, and inserts new text content as a
child of the selected item.

11.6.3.4

Add Child | CData

The Add Child | CData command is available in Grid View only, and inserts a new CDATA
section as a child of the selected item.

11.6.3.5

Add Child | Comment

The Add Child | Comment command is available in Grid View only, and inserts a new Comment
node as a child of the selected item.

11.6.3.6

Add Child | XML

The Add Child | XML command is available in Grid View only and when the file is empty. It
inserts a row for the XML declaration. You must insert the child attributes of the XML declaration
and the values of this attribute. An XML declaration must look something like this:
<?xml version="1.0" encoding="UTF-8"?>

11.6.3.7

Add Child | Processing Instruction

The Add Child | Processing Instruction command is available in Grid View only and inserts a
new Processing Instruction (PI) as a child of the selected item.

11.6.3.8

Add Child | DOCTYPE

The Add Child | DOCTYPE command is available in the Grid View of an empty document. It
inserts a DOCTYPE declaration in an XML document. The DOCTYPE declaration can be used to
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declare an internal DTD subset.

11.6.3.9

Add Child | ExternalID

The Add Child | ExternalID command is available when the DOCTYPE declaration in an XML file
is selected in Grid View. This command inserts a Grid View row for an external identifier (PUBLIC
or SYSTEM). You must enter the type of identifier and its value.

The Text View corresponding to the screenshot of the Grid View shown above looks like this:

Note: A row for ExternalID can be added as a child when the DOCTYPE item is selected, or it
can be inserted or appended when one of the child items of the DOCTYPE item is selected, for
example, the ELEMENT declaration name in the example above.

11.6.3.10

Add Child | ELEMENT

The Add Child | ELEMENT command is available in Grid View only, for DTD documents or when
the DOCTYPE declaration of an XML document is selected. It appends an ELEMENT declaration
to the list of declarations.

11.6.3.11

Add Child | ATTLIST

The Add Child | ATTLIST command is available in Grid View only, for DTD documents or when
the DOCTYPE declaration of an XML document is selected. It appends an ATTLIST declaration to
the list of declarations.

11.6.3.12

Add Child | ENTITY

The Add Child | ENTITY command is available in Grid View only, for DTD documents or when
the DOCTYPE declaration of an XML document is selected. It appends an ENTITY declaration to
the list of declarations.
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Add Child | NOTATION

The Add Child | NOTATION command is available in Grid View only, for DTD documents or when
the DOCTYPE declaration of an XML document is selected. It appends a NOTATION declaration
to the list of declarations.

11.6.4

Convert to
The Convert to command converts a selected item in Grid View to a different item type. This
operation is available only in Grid View on individual items that do not contain any child node.
Placing the cursor over the Convert to command pops up a submenu which contains the items to
which the selected item can be converted.

If the operation would result in a loss of data (for example, converting an attribute to a comment
would result in a loss of the attribute name), a warning dialog box will appear.

11.6.5

Table
The Table menu command can be used only in Grid View. It pops out a sub-menu with
commands that enable you to edit the selection as a table.
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Display as Table

The Display as Table command allows you to switch between the standard Grid View and Table
View of an element in the document.

11.6.5.2

Insert Row

The Insert Row command is enabled in Table View when a row or cell is selected. It inserts a
new row before the selected row. The new row corresponds to an occurrence of the table element.
Mandatory child elements are created for the new element.

11.6.5.3

Append Row

The Append Row command is enabled in Table View when a row or cell is selected. It appends a
new row after the last row of the table. The new row corresponds to an occurrence of the table
element. Mandatory child elements are created for the new element.

11.6.5.4

Ascending Sort

The Ascending Sort command is enabled in Table View when a column or cell is selected. It
sorts the table on the basis of the contents of the selected column, in ascending order. DiffDog
tries to automatically determine what kind of data is used in the column, and sorts on alphabetic
or numeric order, as required. In case of uncertainty, you will be prompted for the sort method to
use (screenshot below).
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Descending Sort

The Descending Sort command is enabled in Table View when a column or cell is selected. It
sorts the table on the basis of the contents of the selected column, in descending order. DiffDog
tries to automatically determine what kind of data is used in the column, and sorts on alphabetic
or numeric order, as required. In case of uncertainty, you will be prompted for the sort method to
use (For a screenshot see chapter Ascending Sort above).

11.6.6

Move Left

The Move Left command is available in Grid View only. It moves the selected node to the left by
one level, thereby changing a child element into a sibling of its parent.

11.6.7

Move Right

The Move Right command is available in Grid View only. It moves the selected node to the right
by one level, thereby turning it into a child element of the preceding sibling element.

11.6.8

Enclose in Element
The Enclose in Element command is enabled in Grid View only. It encloses a selected text
range in a new element. The new element is created inline around the selected text. If you are
editing a document based on a Schema or DTD, you will automatically be presented with a list of
valid choices for the name of the element in which the text is to be enclosed.
For example, in the screenshot below, the text Nanonull in the para element is highlighted.
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When you select the command Grid View | Enclose in Element, the text "Nanonull" is
enclosed in a newly created inline element and a list appears offering a choice for the name of the
element. These elements are defined in the schema as children of para.

The selection you make will be the name of the new element. Alternatively, you can enter some
other name for the element.
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11.7 XML Menu
The XML menu contains commands that relate to XML documents opened in File Comparison
windows.

11.7.1

Check Well-Formedness
F7
The Check Well-Formedness command checks the active document for well-formedness by the
definitions of the XML 1.0 specification. This command is available in both the Text View and Grid
View of File Comparison windows. On running the well-formedness check, a message box
displays the result of the check: whether successful or not.
Note: This command is available for all files with extensions that have been set as XMLconformant in the File Types tab of the DiffDog Options dialog box.

11.7.2

Validate
F8
The Validate command is available in both the Text View and Grid View of File Comparison
windows. It enables you to validate the active XML document against a DTD, XML Schema, or
other schema. The associated schema must be declared in the file being validated. On validating
the document, a message box displays the result of the validation: that is, whether successful or
not.
Note: This command is available for all files with extensions that have been set as XMLconformant in the File Types tab of the DiffDog Options dialog box.
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11.8 Diff and Merge Menu
The Diff and Merge Menu lists commands to manage file and directory comparisons. Depending
on the active comparison window, commands to set the comparison mode, navigate compared
documents in the comparison windows and merge differences in them are also available in this
menu.
Please note that the content of the Diff and Merge menu changes dynamically, depending on
the type of comparison.

11.8.1

File Comparison
The Diff and Merge menu contains the following commands when a file comparison takes place.
Textual Comparison Only
Compare as XML
Compare as Binary
Compare According to File Extension Settings
Start Comparision
Next Difference
Previous Difference
Last Difference
First Difference
Display Current Difference
Make Current Difference
Copy from Left to Right
Copy from Right to Left
Show Options Before Comparison
Autostart Comparison
Compare while Editing
Support Recently Compared Pairs

11.8.1.1

Textual Comparison Only

The Textual Comparison Only command changes the comparison mode of a file or directory
comparison to textual comparison. Note that this command is not available if the Quick
Comparison mode is active. To change to the Text Comparison mode in that case, you have to
deactivate the Quick Comparison mode first.

11.8.1.2

Compare as XML

The Compare as XML command changes the comparison mode of a file or directory comparison
to XML comparison. Note that this command is not available if the Quick Comparison mode is
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active. To change to the XML Comparison mode in that case, you have to deactivate the Quick
Comparison mode first.

11.8.1.3

Compare as Binary

The Compare as Binary command changes the comparison mode of a file or directory
comparison to binary comparison. Note that this command is not available if the Quick
Comparison mode is active. To change to the Binary Comparison mode in that case, you have to
deactivate the Quick Comparison mode first.

11.8.1.4

Compare According to File Extension Settings

The Compare According to File Extension Settings command changes the comparison mode
of a file or directory comparison dynamically according to the settings on the File types tab of the
DiffDog Options dialog box. Note that this command is not available if the Quick Comparison
mode is active. To change to the File Extension mode in that case, you have to deactivate the
Quick Comparison mode first.

11.8.1.5

Start Comparision
F5

This command starts comparison for the active comparison window.

11.8.1.6

Next Difference
Alt+Down

This command selects the next difference as the current difference.

11.8.1.7

Previous Difference
Alt+Up

This command selects the previous difference as the current difference.
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Last Difference
Alt+End

This command selects the last difference as the current difference.

11.8.1.9

First Difference
Alt+Home

This command selects the first difference as the current difference.

11.8.1.10

Display Current Difference
Ctrl+Enter

This command scrolls through the document to display the current difference.

11.8.1.11

Make Current Difference
Alt+Enter

This command makes the selected difference the current difference, and sets it as the difference
from which to navigate.

11.8.1.12

Copy from Left to Right
Alt+Right

This command copies text of the selected difference from the document in the left pane to the
document in the right pane.

11.8.1.13

Copy from Right to Left
Alt+Left

This command copies text of the selected difference from the document in the right pane to the
document in the left pane.
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Show Options Before Comparison

When this command is toggled on for a Comparison Window, the Comparison Options dialog
box is displayed each time a comparison is made in that window. Note that the Comparison
Options dialog box is not displayed before comparisons made dynamically by DiffDog while you
edit a document.

11.8.1.15

Autostart Comparison

When toggled on, this command automatically starts a comparison when both files or both
directories are selected and opened in the comparison window. If this option is toggled off, then a
comparison (file or directory) must be explicitly started (by clicking Diff and Merge | Start
Comparison).

11.8.1.16

Compare while Editing

This command is a toggle to compare or not compare documents in File Comparison windows
while editing. If toggled on, differences are highlighted as you edit. If toggled off, highlighting of
differences is turned off in both documents as soon as you start typing in either document; to
highlight differences after editing, you must run a comparison (by clicking Diff and Merge | Start
Comparison).

11.8.1.17

Support Recently Compared Pairs

This command is a toggle that switches on and off the option of suggesting recently compared
files or directories each time a file or directory is selected in one pane.

11.8.2

Directory Comparison
The Diff and Merge Menu for directory comparisons lists commands to (i) set comparison
modes, (ii) start a comparison, (iii) navigate compared documents and display differences in
Directory Comparison windows, (iv) merge differences in them, (v) synchronize directories, and (vi)
set the comparison management options.
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Show Files in ZIP Archives

The Show files in ZIP archives option is deactivated by default, therefore only the file itself will
be shown in directory comparisons. To be able to expand the file and view its content you must
activate the Show files in ZIP archives option.

11.8.2.2

Compare Only Size and Modification Date

The Compare only Size and Modification Date command compares files within directories and
subdirectories by size and date modified. This mode is either toggled on or off. When toggled off,
the four file comparison modes become available. Selecting one of the file comparison modes
causes directories to be compared in terms of their contents as text, XML, or binary files.
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Copy from Left to Right
Alt+Right

This command copies the selected non-equal file from the (directory in the) left pane to the
(directory in the) right pane.

11.8.2.4

Copy from Right to Left
Alt+Left

This command copies the selected non-equal file from the (directory in the) right pane to the
(directory in the) left pane.

11.8.2.5

Synchronize Directories

This command opens the Synchronize directories dialog box and populates it with all non-equal
files that are present in at least one of the directories.

11.8.2.6

Synchronize Selected Directory

This command is only available if at least one of the compared directories contains a subdirectory which is selected. It opens the Synchronize directories dialog box and populates it
with all non-equal files that are present in the selected sub-directory.
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11.9 Tools Menu
The Tools Menu contains commands that enable you to set the application and comparison
options and to customize the appearance of DiffDog.

11.9.1

DiffDog Options...

This command opens the DiffDog Options dialog box where you can set the options for the
application, file comparison, and directory comparison, and define the file types that can be
compared.

11.9.2

Comparison Options...

This command opens the Comparison Options dialog box which provides separate tabs to set
the comparison options for file comparison and directory comparison.
Please note that the Comparison Options dialog box is displayed automatically before a
comparison is started if the Show Options Before Comparison option is toggled on in the Diff
and Merge menu.

11.9.3

Comparison Document Options
This command is applicable if you have licensed DiffDog Server and intend to run with it
comparison files (.filedif and .dirdif) created with DiffDog, see also Running comparisons with
DiffDog Server.
When you run .filedif or .dirdif files with DiffDog Server, you might want to optionally redirect the
report with the comparison results to an XML or text file. The dialog below lets you specify the
format and path of the output report.
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Customize...
The Customize... command lets you customize DiffDog to suit your personal needs.

11.9.4.1

Commands

The Commands tab allows you customize your menus or toolbars.

To add a command to a toolbar or menu:
1.

Select the menu option Tools | Customize. The Customize dialog box appears.
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3.

4.

Tools Menu

Select the All Commands category in the Categories list box. The available commands
appear in the Commands list box.
Click on a command in the Commands list box and drag it to an existing menu or
toolbar. An I-beam appears when you place the cursor over a valid position to drop the
command.
Release the mouse button at the position you want to insert the command.
A small button appears at the tip of mouse pointer when you drag a command. The "x"
below the pointer means that the command cannot be dropped at the current cursor
position.
The "x" disappears whenever you can drop the command (over a tool bar or menu).
Placing the cursor over a menu when dragging opens it, allowing you to insert the
command anywhere in the menu.
Commands can be placed in menus or toolbars. If you created you own toolbar you can
populate it with your own commands/icons.

Note:

11.9.4.2

You can also edit the commands in the context menus (right-click anywhere to open the
context menu), using the same method. Click the Menu tab and then select the specific
context menu available in the Context Menus combo box.

Toolbars

The Toolbars tab allows you to activate or deactivate specific toolbars, as well as create your
own specialized ones.
DiffDog toolbars contain symbols for the most frequently used menu commands. For each symbol
you get a brief "tool tip" explanation when the mouse cursor is directly over the item and the
status bar shows a more detailed description of the command.
You can drag the toolbars from their standard position to any location on the screen, where they
appear as a floating window. Alternatively, you can also dock them to the left or right edge of the
main window.
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Show text labels
This option displays explanatory text below toolbar icons when activated. You can activate or
deactivate this option for each toolbar individually.
To activate or deactivate a toolbar:
Click the check box to activate (or deactivate) the specific toolbar.
To create a new toolbar:
1.
2.

Click the New... button, and give the toolbar a name in the Toolbar Name dialog box
that appears.
Drag commands to the toolbar in the Commands tab of the Customize dialog box.

To reset the Menu Bar:
1.
2.

Click the Menu Bar entry.
Click the Reset button, to reset the menu commands to the state they were in when
DiffDog was installed.

To reset all toolbar and menu commands:
1.

2.

Click the Reset All button to reset all the toolbar commands to the state they were when
the program was installed. A prompt appears stating that all toolbars and menus will be
reset.
Click Yes to confirm the reset.
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To change a toolbar name:
Click the Rename... button to edit the name of the toolbar.
This option is available only for user-defined toolbars.
To delete a toolbar:
1.
2.
3.

Select the toolbar you want to delete in the Toolbars list box.
Click the Delete button. A prompt appears, asking if you really want to delete the toolbar.
Click Yes to confirm the deletion.

This option is available only for user-defined toolbars.

11.9.4.3

Keyboard

The Keyboard tab allows you to define (or change) keyboard shortcuts for any DiffDog
command.

In the Set accelerator for drop-down list, you can differentiate between shortcuts that are valid in
the Default menu or in the DiffDog Design menu.
To assign a new Shortcut to a command:
1.
2.
3.

Select the All Commands category using the Category combo box.
Select the command you want to assign a new shortcut to, in the Commands list box.
Click in the Press New Shortcut Key text box, and press the shortcut keys that are
to activate the command.
The shortcuts appear immediately in the text box. If the shortcut was assigned
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previously, then that function is displayed below the text box.
Click the Assign button to assign the shortcut.
The shortcut now appears in the Current Keys list box.
(To clear this text box, press any of the control keys, CTRL, ALT or SHIFT).

To de-assign or delete a shortcut:
1.
2.
3.

Click the shortcut you want to delete in the Current Keys list box.
Click the Remove button.
Click the Close button to confirm.

To reset all shortcut keys:
1.

2.

Click the Reset All button to reset all the shortcut keys to the state they were when the
program was installed.
A prompt appears stating that all toolbars and menus will be reset.
Click Yes to confirm the reset.

Currently assigned keyboard shortcuts
Hotkeys by key
Ctrl+C

Copy

Ctrl+F

Find

Ctrl+G

Go to Line/Char

Ctrl+H

Replace

Ctrl+O

Open

Ctrl+P

Print

Ctrl+S

Save

Ctrl+V

Paste

Ctrl+X

Cut

Ctrl+Z

Undo

F1

Table Of Contents

F3

Find Next

F5

Start Comparison

F7

Check WellFormedness

F8

Validate
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Alt+Enter

Make Current Difference

Ctrl+Enter

Display Current
Difference

Delete

Delete

Shift+Delete

Cut

Alt+Backspace

Undo

Ctrl+Insert

Copy

Shift+Insert

Paste

Alt+Down

Next Difference

Alt+Up

Previous Difference

Alt+Home

First Difference

Alt+End

Last Difference

Alt+Left

Copy from Right to Left

Alt+Right

Copy from Left to Right

Hotkeys by function
Check Well-Formedness

F7

Copy

Ctrl+C

Copy from Left to Right

Alt+Right

Copy from Right to Left

Alt+Left

Cut

Ctrl+X

Delete

Delete

Display Current Difference

Ctrl+Enter

Find

Ctrl+F

Find Next

F3

First Difference

Alt+Home
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Ctrl+Insert

Shift+Delete
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Hotkeys by function

11.9.4.4

Go to Line/Char

Ctrl+G

Last Difference

Alt+End

Make Current Difference

Alt+Enter

Next Difference

Alt+Down

Open

Ctrl+O

Paste

Ctrl+V

Previous Difference

Alt+Up

Print

Ctrl+P

Replace

Ctrl+H

Save

Ctrl+S

Start Comparison

F5

Table Of Contents

F1

Undo

Ctrl+Z

Validate

F8

Shift+Insert

Alt+Backspace

Menu

The Menu tab allows you to customize the main menu bars as well as the context menus.
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You can customize the Default, the file compare, and the Directory comparemenu bars.
The Default menu is the one visible when no comparison windows are open in DiffDog.

The File compare menu is the menu bar that is displayed when at least one File Comparison
window has been opened and is active.

The Directory compare menu is the menu bar visible when at least one Directory Comparison
window has been opened and is active.
Menu shadows
The Menu shadows check box, which is checked by default, can be deactivated if you do not
want all your menus to have shadows.
To customize a menu:
1.
2.

Select the menu bar you want to customize from the Show Menus for combo box.
Click the Commands tab, and drag the commands to the menu bar of your choice.

To delete commands from a menu:
1.
2.

Select the menu option Tools | Customize to open the Customize dialog box.
Do one of the following:
Right-click the command or icon representing the command and select the Delete
option from the context menu.
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Drag the command away from the menu, and drop it as soon as the check mark icon
appears below the mouse pointer.
To reset either of the menu bars:
1.
2.
3.

Select either the Default, the File compare, or the Directory compare entry in the Show
Menus for combo box.
Click the Reset button just below the menu name.
A prompt appears asking if you are sure you want to reset the menu bar.
Click Yes.

To customize any of the context menus (right-click menus):
1.
2.

Select the context menu from the Select context menu combo box.
The context menu you selected appears.
Click the Commands tab, and drag the commands to the context menu.

To delete commands from a context menu:
1.
2.

Select the menu option Tools | Customize to open the Customize dialog box.
Do one of the following:
Right-click on the command or icon representing the command and select the Delete
option from the context menu.
Drag the command away from the context menu, and drop it as soon as the check
mark icon appears below the mouse pointer.

To reset any of the context menus:
1.
2.

Select the context menu from the combo box.
Click the Reset button just below the context menu name.
A prompt appears asking if you are sure you want to reset the context menu.

To close a context menu window:
Do one of the following:
Click on the Close icon at the top right of the title bar.
Click the Close button of the Customize dialog box.
To change the appearance of menus:
If required, deactivate the Menu shadows check box.

11.9.4.5

Options

The Options tab allows you to set general environment settings.
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When active, the Show ScreenTips on toolbars check box displays a popup when the mouse
pointer is placed over an icon in any of the icon bars. The popup contains a short description of
the icon function, as well as the associated keyboard shortcut, if one has been assigned.
The Show shortcut keys in ScreenTips check box allows you to decide whether or not you
want to have the shortcut displayed in the tooltip.
When active, the Large icons check box switches between the standard size icons, and larger
versions of the icons.
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11.10 Window Menu
The Windows menu provides commands to arrange and organize the display of open windows.

You can cascade the open windows, tile them horizontally or vertically, or arrange document
icons once you have minimized them. You can also switch to an open document window directly
from the menu.

11.10.1 Cascade

The Cascade command rearranges all open document windows so that they are all cascaded
(i.e., staggered) on top of each other.

11.10.2 Tile Horizontally

The Tile horizontally command rearranges all open document windows as horizontal tiles,
making them all visible at the same time.

11.10.3 Tile Vertically

The Tile vertically command rearranges all open document windows as vertical tiles, making
them all visible at the same time.

11.10.4 Currently Open Windows List
This list shows all currently open windows and lets you quickly switch between them.
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The list is ordered in the sequence in which windows were opened. The active window is indicated
with a check mark.
You can also use the Ctrl+TAB or Ctrl+F6 keyboard shortcuts to cycle through the open
windows.

11.10.5 Windows...
At the bottom of the list of open windows is the Windows... command. Clicking this entry opens
the Windows dialog box, which displays a list of all open windows and provides commands that
can be applied to the selected window(s). A window is selected by clicking on its name.

The Cascade and Tile options are available only when more than one window is selected. The
Activate option is enabled only when a single window is selected.
Warning: To exit the Windows dialog box, click OK; do not click the Close Window(s) button
in the dialog box. The Close Window(s) button closes the window(s) currently selected in the
Windows dialog box.
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11.11 Help Menu
Table of Contents
Description
Opens the onscreen help manual of DiffDog with the Table of Contents displayed in the
left-hand-side pane of the Help window. The Table of Contents provides an overview of
the entire Help document. Clicking an entry in the Table of Contents takes you to that
topic.

Index
Description
Opens the onscreen help manual of DiffDog with the Keyword Index displayed in the
left-hand-side pane of the Help window. The index lists keywords and lets you navigate
to a topic by double-clicking the keyword. If a keyword is linked to more than one topic,
a list of these topics is displayed.

Search
Description
Opens the onscreen help manual of DiffDog with the Search dialog displayed in the lefthand-side pane of the Help window. To search for a term, enter the term in the input
field, and press Return. The Help system performs a full-text search on the entire Help
documentation and returns a list of hits. Double-click any item to display that item.

Software Activation
Description
After you download your Altova product software, you can license—or activate—it using
either a free evaluation key or a purchased permanent license key.
Free evaluation key. When you first start the software after downloading and
installing it, the Software Activation dialog will pop up. In it is a button to
request a free evaluation key-code. Enter your name, company, and e-mail
address in the dialog that appears, and click Request Now! The evaluation key
is sent to the e-mail address you entered and should reach you in a few
minutes. Now enter the key in the key-code field of the Software Activation
dialog box and click OK to start working with your Altova product. The software
will be unlocked for a period of 30 days.
Permanent license key. The Software Activation dialog contains a button to
purchase a permanent license key. Clicking this button takes you to Altova's
online shop, where you can purchase a permanent license key for your product.
There are two types of permanent license: single-user and multi-user. Both will
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be sent to you by e-mail. A single-user license contains your license-data and
includes your name, company, e-mail, and key-code. A multi-user license
contains your license-data and includes your company name and key-code.
Note that your license agreement does not allow you to install more than the
licensed number of copies of your Altova software on the computers in your
organization (per-seat license). Please make sure that you enter the data
required in the registration dialog exactly as given in your license e-mail.
Note:

When you enter your license information in the Software Activation dialog,
ensure that you enter the data exactly as given in your license e-mail. For
multi-user licenses, each user should enter his or her own name in the Name
field.

Your license email and the different ways to license (activate) your
Altova product
The license email that you receive from Altova will contain:
Your license details (name, company, email, key-code)
As an attachment, a license file with a .altova_licenses file
extension
To activate your Altova product, you can do one of the following:
Enter the email-supplied license details in the Altova product's
Software Activation dialog, and click OK.
Save the license file (.altova_licenses) to a suitable location,
double-click the license file, enter any requested details in the
dialog that appears, and finish by clicking Apply Keys.
Save the license file (.altova_licenses) to any suitable location,
and upload it from this location to the license pool of your Altova
LicenseServer. You can then either: (i) acquire the license from
your Altova product via the product's Software Activation dialog, or
(ii) assign the license to the product from Altova LicenseServer.
For more information about licensing via LicenseServer, read the
rest of this topic.

The Software Activation dialog (screenshot below) can be accessed at any time by
clicking the Help | Software Activation command.
You can activate the software by either:
Entering the license key information (click Enter a New Key Code), or
Acquiring a license via an Altova LicenseServer on your network (click Use
Altova LicenseServer, located at the bottom of the Software Activation
dialog). The Altova LicenseServer must have a license for your Altova product in
its license pool. If a license is available in the LicenseServer pool, this is
indicated in the Software Activation dialog (screenshot below), and you can
click Save to acquire the license.
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After a machine-specific (aka installed) license has been acquired from a
LicenseServer, it cannot be returned to the LicenseServer for a period of seven
days. After that time, you can return the machine license to LicenseServer
(click Return License) so that this license can be acquired from LicenseServer
by another client. (A LicenseServer administrator, however, can unassign an
acquired license at any time via the administrator's Web UI of LicenseServer.)
Note that the returning of licenses applies only to machine-specific licenses,
not to concurrent licenses.
Check out license
You can check out a license from the license pool for a period of up to 30 days
so that the license is stored on the product machine. This enables you to work
offline, which is useful, for example, if you wish to work in an environment where
there is no access to your Altova LicenseServer (such as when your Altova
product is installed on a laptop and you are traveling). While the license is
checked out, LicenseServer displays the license as being in use, and the
license cannot be used by any other machine. The license automatically
reverts to the checked-in state when the check-out period ends. Alternatively, a
checked-out license can be checked in at any time via the Check in button of
the Software Activation dialog.
To check out a license, do the following: (i) In the Software Activation dialog,
click Check out License (see screenshot above); (ii) In the License Check-out
dialog that appears, select the check-out period you want and click Check out.
The license will be checked out. The Software Activation dialog will display the
check-out information, including the time when the check-out period ends. The
Check out License button in the dialog changes to a Check In button. You
can check the license in again at any time by clicking Check In. Because the
license automatically reverts to the checked-in status, make sure that the
check-out period you select adequately covers the period during which you will
be working offline.
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Note: For license check-outs to be possible, it must be enabled on the
LicenseServer. If this functionality has not been enabled, you will get an error
message to this effect. In this event, contact your LicenseServer administrator.
Copy Support Code
Click Copy Support Code to copy license details to the clipboard. This is the
data that you will need to provide when requesting support via the online
support form.
Altova LicenseServer provides IT administrators with a real-time overview of all Altova
licenses on a network, together with the details of each license, as well as client
assignments and client usage of licenses. The advantage of using LicenseServer
therefore lies in administrative features it offers for large-volume Altova license
management. Altova LicenseServer is available free of cost from the Altova website. For
more information about Altova LicenseServer and licensing via Altova LicenseServer,
see the Altova LicenseServer documentation.

Order Form
Description
When you are ready to order a licensed version of the software product, you can use
either the Order license key button in the Software Activation dialog (see previous
section) or the Help | Order Form command to proceed to the secure Altova Online
Shop.

Registration
Description
Opens the Altova Product Registration page in a tab of your browser. Registering your
Altova software will help ensure that you are always kept up to date with the latest
product information.

Check for Updates
Description
Checks with the Altova server whether a newer version than yours is currently available
and displays a message accordingly.

Support Center
Description
A link to the Altova Support Center on the Internet. The Support Center provides FAQs,
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discussion forums where problems are discussed, and access to Altova's technical
support staff.

FAQ on the Web
Description
A link to Altova's FAQ database on the Internet. The FAQ database is constantly
updated as Altova support staff encounter new issues raised by customers.

Download Components and Free Tools
Description
A link to Altova's Component Download Center on the Internet. From here you can
download a variety of companion software to use with Altova products. Such software
ranges from XSLT and XSL-FO processors to Application Server Platforms. The software
available at the Component Download Center is typically free of charge.

DiffDog on the Internet
Description
A link to the Altova website on the Internet. You can learn more about DiffDog and
related technologies and products at the Altova website.
About DiffDog
Description
Displays the splash window and version number of your product. If you are using the 64bit version of DiffDog, this is indicated with the suffix (x64) after the application name.
There is no suffix for the 32-bit version.
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11.12 Status and Result Messages
Status and result messages for comparisons appear in the Comparison Window Status Bar,
which is located at the bottom of each Comparison Window.
Status messages
Status messages indicate the status of that particular comparison, essentially whether files/
directories have been selected; whether a comparison has been carried out; and what kind of
comparison was carried out (that is, which Comparison Mode was used).
Result messages
If differences are found, a summary of the comparison results is provided by result messages in
the Status Bar. If no differences are found, this is also reported in the Status Bar. The result
message lists number and type of differences in the form:
Result: n differences n in left pane only n in right pane only
In File Comparison windows, Text Comparison counts differences in terms of blocks of contiguous
differences, even if the Show Differences within Lines option is selected. So if there are six
differences in four lines, four differences are reported. If two or more lines with differences appear
consecutively, without being interrupted by a line that is equal in both files, only one difference is
counted in the result message. In XML comparisons, differences are counted in terms of nodes.
Note that a difference is counted when the node exists in both documents but is different. If the
node does not exist in one document, such a node is listed as being either present in Left Only
or in Right Only. In Binary Comparisons, it is only stated whether or not the file pair is different;
no details concerning the number or location of differences are available.
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12 Command Line Options
In addition to running DiffDog from the graphical user interface, you can also trigger comparisons
from a command line window. The file or directory paths to be compared can be supplied to the
DiffDog executable as arguments. Additional comparison options (further described below) can
also be supplied. When the command is executed, DiffDog starts, opens the directories or files in
the appropriate comparison window, carries out a comparison, and displays the results.
Note:

Calling the DiffDog executable at the command line will open the DiffDog graphical user
interface with the options you specified. It is not possible to display the comparison
outcome in the command line window, or to export the comparison results from the
command line.

To run DiffDog from the command line interface:
1.
2.

Type cmd in the Windows search box, and press Enter to open a new command line
window.
Change the current directory to the directory where DiffDog is installed, for example:
cd C:\Program Files (x86)\Altova\DiffDog2018\

3.

Call DiffDog.exe and supply the file or directory names to be compared as arguments,
as well as any optional command line options. For example, in the command below, two
text files are compared so the options /cF /mT are explicitly set:
DiffDog.exe /cF /mT file1.txt file2.txt

For reference to all available options, see Command Line Syntax.
If DiffDog is already running when you start it from the command line, it will start as a new
instance, provided that the option Allow Multiple Instances is enabled from Tools | DiffDog
Options | Application tab. If Allow Multiple Instances is disabled, then the new comparison is
opened in a new comparison window of an already running DiffDog instance.
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12.1 Command Line Syntax
The command line options are simple switches and are optional. If not specified, the option is off.
For best results, it is recommended that you specify the /cD or /cF option, to explicitly instruct
DiffDog that you are comparing either files or directories. Note, however, that, if you use DiffDog
as a differencing tool for a source control system, some control systems will not accept additional
arguments except the file names.
Although they are organized into groups, the options listed below can appear in any order. The
options are not case-sensitive, and you can use either the minus sign (-) or the slash (/) before
options. The command line syntax is as follows:
DiffDog.exe [source name1 name2 [name3]] [general options] [compare mode]
[compare options] [filter filtername] [directory compare options] [file-filter
file filtername]

source:
/cd
compare directories
/cf
compare files
name1 name2:
names of files or directories to compare
general options
/h
opens the help file
compare mode:
/mE
compare according to extension settings
/mX
compare as XML
/mT
compare as text
/mB
compare binary
compare options:
/dD
detailed differencing
/dL
show differences within lines
/iB
ignore blank lines
/iC
ignore case but not in node names
/iCN
ignore case
/iD
ignore node depth
/iN
ignore namespace
/iNT A CD C PI D X
ignore node types (Attributes, CData, Comments, Processing Instructions, Doctype,
XML declaration)
/iOA
ignore order of attributes
/iOC
ignore order of child nodes
/iOC A G groupname T
ignore order of child nodes and add attributes as comparison criteria (All Attributes,
Specific Attributes as defined in Group groupname, Add Element Text as Comparison
Criteria)
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/iP
/iT
/e
/wN
/wS

Command Line Syntax

ignore prefixes
ignore text (XML)
resolve entities
normalize whitespaces
strip all whitespaces

filter:
/f
filter out specific elements/attributes
filtername:
name of predefined filter
directory compare options:
/iS
ignore sub-directories
file-filter:
/fD
filter out specific files/directories in directory comparison
file filtername:
name of predefined file-filter
Note:

Some Comparison Options apply to XML Comparison Mode only (for example, /dD, /iN
and /iNT). These options will therefore be ignored if the [compare mode] option is not /
mX.
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12.2 Command Line Examples
In the examples below, it is assumed that the current working directory is the directory where
DiffDog is installed; therefore, all commands start with DiffDog.exe. If your working directory is
different, make sure to enter the full path to the DiffDog executable instead (for example, "C:
\Program Files (x86)\Altova\DiffDog2018\DiffDog.exe"). If the path to the executable contains
spaces, do not forget to enclose it within quotes. The same applies for any referenced file or
directory names which include spaces in their name.
To compare two files according to file extension, use:
DiffDog.exe /cF c:\work\Alice.txt c:\work\Bob.txt /mE

To compare two XML files in XML mode, with detailed differencing enabled (so that merge from
right to left, or left to right is possible), use:
DiffDog.exe /cF c:\work\Alice.xml c:\work\Bob.xml /mX /dD

To compare only the XML structure of the files and ignore text, use:
DiffDog.exe /cF c:\work\Alice.xml c:\work\Bob.xml /mX /iT

To compare two directories, use:
DiffDog.exe /cD c:\work1 c:\work2

To compare two directories ignoring subdirectories, use:
DiffDog.exe /cD c:\work1 c:\work2 /iS

The following command compares XML files in two directories by applying a predefined filter
(created previously from the graphical user interface), see also Filtering the content of compared
directories. Notice that quotes were used since the filter name contains spaces.
DiffDog.exe /cD c:\work1 c:\work2 /mX /fD "xml conformant files"
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13 Version Control System Integration
DiffDog can easily be integrated with version control systems that provide the option to use a
custom (external) executable for differencing and merging.
For your convenience, this section provides instructions on how to configure miscellaneous
version control systems to use DiffDog as differencing and/or merging tool. If your version control
system is not listed, or if it has a different version, refer to its documentation for instructions on
how to use a custom differencing or merging tool.
This section includes the following topics:
Integrating DiffDog with Git
Integrating DiffDog with TortoiseSVN
Integrating DiffDog with SmartSVN
Other Version Control Systems
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13.1 Integrating DiffDog with Git
If you are using Git (https://www.git-scm.com/) as version control system, you can set DiffDog as
Git differencing tool. You can also integrate DiffDog with any Git-based tool that provides the
option to define a custom external differencing tool (for example, gitk). The configuration
instructions below were tested for Git 1.9.4; they are likely to be similar for other Git versions. For
further information about integrating Git with external differencing tools, refer to the Git user's
manual.

To set DiffDog as the Git differencing tool:
Add or edit the following lines in the .gitconfig file (this file is located in the user home
directory, typically: C:\Users\<username>\.gitconfig):
[diff]
tool = diffdog
[difftool "diffdog"]
cmd = "'C:/Program Files/Altova/DiffDog2018/DiffDog.exe'"
"$LOCAL" "$REMOTE"

Note:

If you are using DiffDog 32-bit on a 64-bit operating system, adjust the path to the DiffDog
executable so that it points to C:/Program Files (x86) instead of C:/Program Files.

To check whether DiffDog is set as differencing tool:
Open the Git shell and enter the command git difftool --tool-help, as shown
below.

To view changes to a Git repository file in DiffDog:
1.

Open the Git repository in the Git shell, and enter the command git difftool
<changed file>, for example:
git difftool MyFile.txt

2.

When prompted to confirm whether DiffDog should be launched, type Y, and then press
Enter. To run DiffDog without being prompted first, use the command git difftool -y
<changed file>.

Note that the difftool command does not yield results if you provide an unchanged file as
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argument.

To configure DiffDog as differencing tool in the Git graphical user interface:
1.
2.
3.

Run gitk (for example, by right-clicking on a directory which is under Git control, and
selecting Git History).
On the Edit menu, click Preferences.
Under External diff tool, click Choose and select the path to the DiffDog executable (for
example, C:/Program Files/Altova/DiffDog2018/DiffDog.exe).

In the Git graphical user interface, you can now use the External diff command to view
in DiffDog the changes between two Git commits.
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13.2 Integrating DiffDog with TortoiseSVN
If you are using TortoiseSVN (https://tortoisesvn.net/) as Subversion client, you can set DiffDog as
the program used for comparing different revisions of files. Although the configuration instructions
below apply for TortoiseSVN 1.8.8, they are likely to be similar for other versions. For further
information, refer to the TortoiseSVN user's manual.

To set DiffDog as the TortoiseSVN differencing tool:
1.
2.
3.

Right-click any folder, and select TortoiseSVN | Settings.
Click Diff Viewer.
Click External, and enter the path to the DiffDog executable in the format below.
C:/Program Files/Altova/DiffDog2018/DiffDog.exe %base %mine

Note:

If you are using DiffDog 32-bit on a 64-bit operating system, adjust the path so that it
points to C:/Program Files (x86) instead of C:/Program Files.
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13.3 Integrating DiffDog with SmartSVN
If you are using SmartSVN (https://www.smartsvn.com/) as Subversion client, you can add
DiffDog as file comparison tool, in addition to the built-in comparison tool. The configuration
instructions below apply for SmartSVN 8.5, but they are likely to be similar for other versions.

To set DiffDog as the comparison tool:
1.
2.
3.
4.
5.
6.

Note:

7.

Run SmartSVN.
On the Edit menu, click Preferences.
Under Tools, click File Compare.
Click Add, and select External diff tool.
Next to File Pattern, enter a pattern that matches file types that you wish to compare
with DiffDog, for example *.xml.
Next to Command, enter the path to the DiffDog executable, for example C:/Program
Files/Altova/DiffDog2018/DiffDog.exe.
If you are using DiffDog 32-bit on a 64-bit operating system, adjust the path so that it
points to C:/Program Files (x86) instead of C:/Program Files.
Next to Arguments, enter ${leftFile} ${rightFile}.
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13.4 Other Version Control Systems
Borland StarTeam Cross-Platform Client 2008 R2
https://www.microfocus.com/products/change-management/starteam/
The following steps integrate Altova DiffDog into Borland Star Team:
1. Use the StarTeam client personal options (Tools | Personal options | File | Alternate
applications)
2. Compare utility: Enter the DiffDog full path.
3. Compare utility options: $file1 $file2.

Dynamsoft SourceAnywhere for VSS 5.3.2 Client
http://www.dynamsoft.com/Products/SAW_Overview.aspx
The following steps will integrate Altova DiffDog into Dynamsoft SourceAnywhere for VSS:
1. Go to the Dynamic SourceAnywhere For VSS client Options.
2. Specify the DiffDog full path as External application for diff/merge, with the arguments: %
FIRST_FILE%” “%SECOND_FILE%.
Warning: Do not perform these settings from the Altova product options, as there is no possibility
of inserting the external application parameters.

Dynamsoft SourceAnywhere Hosted Client (22252)
http://www.dynamsoft.com/Products/SourceAnywhere-Hosting-Version-Control-SourceControl.aspx
Dynamsoft SourceAnywhere Standalone 2.2 Client
http://www.dynamsoft.com/Products/SourceAnywhere-SourceSafe-VSS.aspx
The following steps will integrate Altova DiffDog into Dynamsoft SourceAnywhere Hosted and
Dynamsoft SourceAnywhere Standalone:
1. Click the Advanced button of the Source Control tab.
2. Specify the DiffDog full path as External program application for diff/merge with
arguments %FIRST_FILE%” “%SECOND_FILE%.

Jalindi Igloo 1.0.3
http://www.jalindi.com/igloo/
The following steps will integrate Altova DiffDog into Jalindi Igloo:
1. Start the Show differences command in your Altova application or other application that
accesses the source control system's differencing tool.
2. Open the Show Differences or Merge Files panel.
3. Set the External Diff Command by entering the DiffDog full file path as the External Diff
EXE path.
Warning: When using the default diff editor CvsConflictEditor, you might have problems
comparing files with excessively long lines. We recommended that you "pretty print" all files
(particularly .ump files) before storing them in the repository. This limits the line length, thus
avoiding problems with the CVSConflictEditor.
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March-Hare CVS Suite Client 2008 (3321)
https://www.march-hare.com/cvsnt/en.asp
The following steps will integrate Altova DiffDog into Marc-Hare CVS Suite 2008:
1. Go to the TortoiseCVS Preferences and choose the Tools tab.
2. Specify the DiffDog full path as Diff application, and the parameters %1 %2 as two-way
differencing parameters.

Microsoft Visual Source Safe 2005 with CTP
https://msdn.microsoft.com/en-us/vstudio/aa718670.aspx
The following steps will integrate Altova DiffDog into Microsoft SourceSafe 2005:
1. Click the Advanced button of the Source Control tab.
2. Click the Custom Editors tab and enter C:\Program Files\Altova\DiffDog2018
\DiffDogexe %1 %2 in the Command Line field.
3. In the Operation combo box, select File Difference.

Microsoft Team Foundation Server 2008/2010 MSSCCI Provider
https://www.microsoft.com/en-us/download
Requirements: Visual Studio 2008 Team Explorer or Visual Studio 2008 with Team Explorer
2008.
The following steps will integrate Altova DiffDog into Microsoft Visual Studio Team System 2008
Team Foundation Server MSSCCI Provider:
1. In the manager (Visual Studio 2008 Team Explorer or Visual Studio 2008) options,
configure Altova DiffDog as new user tool
2. Choose Visual Studio Team Foundation Server source as the plug-in.
3. Configure a new user tool specifying: (i) the extensions of the files you wish to compare
with DiffDog; and (ii) the DiffDog full file path.

Perforce P4V 2008.1
https://www.perforce.com/
The following steps will integrate Altova DiffDog into Perforce 2008:
1. Click the Advanced button of the Source Control tab.
2. Choose the tab Diff in the Preferences panel.
3. Check as default differencing application the field “Other application” and enter the DiffDog
full file path.

PushOK CVS SCC NT 2.1.2.5
PushOK CVS SCC x64 version 2.2.0.4
PushOK SVN SCC 1.5.1.1
PushOK SVN SCC x64 version 1.6.3.1
http://www.pushok.com/soft_cvs.php
The following steps will integrate Altova DiffDog into PushOK CVS NT and PushOK SVN SCC:
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Click the Advanced button of the Source Control tab.
Choose the CVS Executables tab.
Select the value External merge/compare tool into the Diff/Merge field.
Insert the DiffDog full file path.
Edit the value %first %second into the "2 way diff cmd" field.

Warning: When using the default differencing editor CvsConflictEditor, you might have problems
comparing files with excessively long lines. We recommended that you "pretty print" all files
(particularly .ump files) before storing them in the repository. This limits the line length, thus
avoiding problems with the CVSConflictEditor.

QSC Team Coherence Client 7.2.1.35
http://www.teamcoherence.com
The following steps will integrate Altova DiffDog into Team Coherence Version Manager:
1. Go to Team Coherence client Options “Difference Viewer”.
2. Specify as the Default Difference Viewer application, the DiffDog full file path.
3. Specify as parameters: "$LF $RF".
Warning: It is possible that the new settings will only be applied after a Windows log off.

Surround SCM Client 2009.0.0
https://www.perforce.com/products/surround-scm
The following steps will integrate Altova DiffDog into Seapine Surround SCM:
1. Go to the Surround SCM client user options (Diff/Merge) section.
2. Edit the Diff/Merge settings to compare with a selected application.
3. Enter the DiffDog full path with the parameters “%1” “%2”.
4. Restart the Surround SCM client and the Altova products.

SourceGear Vault 4.1.4 Client
http://www.sourcegear.com/vault
The following steps will integrate Altova DiffDog into SourceGear Fortress and SourceGear Vault:
1. Click the Advanced button of the Source Control tab.
2. Set the Diff/Merge Vault options by specifying as the differencing program the DiffDog full
path and using the Arguments:
/ro1 /ro2 /title1:"%LEFT_LABEL%" /title2:"%RIGHT_LABEL%" "%LEFT_PATH%" "%
RIGHT_PATH%"

SourceGear SourceOffsite Client 4.2.0 (Windows)
http://www.sourcegear.com/sos/
The following steps will integrate DiffDog into SourceGear SourceOffsite:
1. Click the Advanced button of the Source Control tab.
2. Specify as “External Programs”, “Application for comparing files” the DiffDog full path.

TamTam CVS SCC 1.2.40, TamTam SVN SCC 1.2.24
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http://www.fieldstonsoftware.com/software/tamtam/index.shtml
The following steps will integrate Altova DiffDog into TamTam CVS SCC and TamTam SVN SCC:
1. Click the Advanced button of the Source Control tab.
2. Specify the DiffDog full file path as the external tool for Diff/Merge and Conflict.
Warning: The default differencing editor CvsConflictEditor, has problems comparing files with
excessively long lines. We recommended that you "pretty print" all files (particularly .ump files)
before storing them in the repository. This limits the line length, avoiding problems with the
CVSConflictEditor.
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14 License Information
This section contains:
Information about the distribution of this software product
Information about software activation and license metering
Information about the intellectual property rights related to this software product
The End-User License Agreement governing the use of this software product
Please read this information carefully. It is binding upon you since you agreed to these terms
when you installed this software product.
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14.1 Electronic Software Distribution
This product is available through electronic software distribution, a distribution method that
provides the following unique benefits:
You can evaluate the software free-of-charge before making a purchasing decision.
Once you decide to buy the software, you can place your order online at the Altova
website and immediately get a fully licensed product within minutes.
When you place an online order, you always get the latest version of our software.
The product package includes a comprehensive integrated onscreen help system. The
latest version of the user manual is available at www.altova.com (i) in HTML format for
online browsing, and (ii) in PDF format for download (and to print if you prefer to have the
documentation on paper).

30-day evaluation period
After downloading this product, you can evaluate it for a period of up to 30 days free of charge.
About 20 days into this evaluation period, the software will start to remind you that it has not yet
been licensed. The reminder message will be displayed once each time you start the application.
If you would like to continue using the program after the 30-day evaluation period, you have to
purchase an Altova Software License Agreement, which is delivered in the form of a key-code that
you enter into the Software Activation dialog to unlock the product. You can purchase your
license at the online shop at the Altova website.

Helping Others within Your Organization to Evaluate the Software
If you wish to distribute the evaluation version within your company network, or if you plan to use it
on a PC that is not connected to the Internet, you may only distribute the Setup programs,
provided that they are not modified in any way. Any person that accesses the software installer
that you have provided, must request their own 30-day evaluation license key code and after
expiration of their evaluation period, must also purchase a license in order to be able to continue
using the product.
For further details, please refer to the Altova Software License Agreement at the end of this
section.
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14.2 Software Activation and License Metering
As part of Altova’s Software Activation, the software may use your internal network and Internet
connection for the purpose of transmitting license-related data at the time of installation,
registration, use, or update to an Altova-operated license server and validating the authenticity of
the license-related data in order to protect Altova against unlicensed or illegal use of the software
and to improve customer service. Activation is based on the exchange of license related data
such as operating system, IP address, date/time, software version, and computer name, along
with other information between your computer and an Altova license server.
Your Altova product has a built-in license metering module that further helps you avoid any
unintentional violation of the End User License Agreement. Your product is licensed either as a
single-user or multi-user installation, and the license-metering module makes sure that no more
than the licensed number of users use the application concurrently.
This license-metering technology uses your local area network (LAN) to communicate between
instances of the application running on different computers.

Single license
When the application starts up, as part of the license metering process, the software sends a
short broadcast datagram to find any other instance of the product running on another computer in
the same network segment. If it doesn't get any response, it will open a port for listening to other
instances of the application.

Multi license
If more than one instance of the application is used within the same LAN, these instances will
briefly communicate with each other on startup. These instances exchange key-codes in order to
help you to better determine that the number of concurrent licenses purchased is not accidentally
violated. This is the same kind of license metering technology that is common in the Unix world
and with a number of database development tools. It allows Altova customers to purchase
reasonably-priced concurrent-use multi-user licenses.
We have also designed the applications so that they send few and small network packets so as
to not put a burden on your network. The TCP/IP ports (2799) used by your Altova product are
officially registered with the IANA (see the IANA website (http://www.iana.org/) for details) and our
license-metering module is tested and proven technology.
If you are using a firewall, you may notice communications on port 2799 between the computers
that are running Altova products. You are, of course, free to block such traffic between different
groups in your organization, as long as you can ensure by other means, that your license
agreement is not violated.
You will also notice that, if you are online, your Altova product contains many useful functions;
these are unrelated to the license-metering technology.
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14.3 Intellectual Property Rights
The Altova Software and any copies that you are authorized by Altova to make are the intellectual
property of and are owned by Altova and its suppliers. The structure, organization and code of the
Software are the valuable trade secrets and confidential information of Altova and its suppliers.
The Software is protected by copyright, including without limitation by United States Copyright
Law, international treaty provisions and applicable laws in the country in which it is being used.
Altova retains the ownership of all patents, copyrights, trade secrets, trademarks and other
intellectual property rights pertaining to the Software, and that Altova’s ownership rights extend to
any images, photographs, animations, videos, audio, music, text and "applets" incorporated into
the Software and all accompanying printed materials. Notifications of claimed copyright
infringement should be sent to Altova’s copyright agent as further provided on the Altova Web
Site.
Altova software contains certain Third Party Software that is also protected by intellectual property
laws, including without limitation applicable copyright laws as described in detail at http://
www.altova.com/legal_3rdparty.html.
All other names or trademarks are the property of their respective owners.
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14.4 Altova End User License Agreement
The Altova End User License Agreement is available here: http://www.altova.com/eula
Altova's Privacy Policy is available here: http://www.altova.com/privacy
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A
Adding,
commands to menus, 149
commands to toolbars, 149
Application status bar, 20
Application window,
description, 20
Assigning,
keyboard shortcuts, 152
shortcuts, 152

B
Binary comparison mode,
definition, 18
Blank lines, 29, 30
Bookmark margin, 40

C
Case sensitivity, 29, 30
Changing,
comparison mode, 66
content of compared files, 48
structure of compared files, 49
synchronization actions, 75
synchronization settings, 74
Collapsing,
all selected nodes, 111
sub-directories, 68
unselected nodes, 111
Command line,
GUI mode, 168
quiet mode, 168
syntax, 169
Commands,
Add Child | ATTLIST, 136
Add Child | Attribute, 134
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Add Child | CData, 135
Add Child | Comment, 135
Add Child | DOCTYPE, 135
Add Child | ELEM ENT, 134, 136
Add Child | ENTITY, 136
Add Child | ExternalID, 136
Add Child | NOTATION, 137
Add Child | Processing Instruction, 135
Add Child | Text, 135
Add Child | XM L, 135
Append | ATTLIST, 133
Append | Attribute, 131
Append | CData, 131
Append | Comment, 131
Append | DOCTYPE, 132
Append | ELEM ENT, 131, 133
Append | ENTITY, 133
Append | ExternalID, 132
Append | NOTATION, 133
Append | Processing Instruction, 132
Append | Text, 131
Append | XM L, 132
Append Row, 138
Ascending Sort, 138
Autostart Comparison, 145
CData, 127
Check Well-Formedness, 141
Close, 114
Close all, 115
Compare According to File Extension Settings, 143
Compare as Binary, 143
Compare as XM L, 142
Compare Directories, 113
Compare Files, 113
Compare Only Size and M odification Date, 146
Compare while Editing, 145
Comparison Options..., 148
Copy, 118
Copy from Left to Right (directories), 147
Copy from Left to Right (files), 144
Copy from Right to Left (directories), 147
Copy from Right to Left (files), 144
Customize..., 149
Cut, 118
Delete, 119
Descending Sort, 139
DiffDog Options..., 148
Display as Table, 138
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Commands,
Display Current Difference, 144
Enclose in Element, 139
Exit, 116
Export differences..., 115
Find next, 119
Find..., 119
First Difference, 144
Go to line/char, 121
Go to Next Bookmark, 124
Go to Previous Bookmark, 124
Grid View, 120
Insert | ATTLIST, 129
Insert | Attribute, 127
Insert | Comment, 127
Insert | DOCTYPE, 128
Insert | ELEM ENT, 127, 129
Insert | ENTITY, 130
Insert | ExternalID, 128
Insert | NOTATION, 130
Insert | Processing Instruction, 128
Insert | Text, 127
Insert | XM L, 128
Insert Row, 138
Insert/Remove Bookmark, 123
Last Difference, 144
M ake Current Difference, 144
M ove Left, 139
M ove Right, 139
Next Difference, 143
Open..., 114
Paste, 118
Pretty-Print XM L Text, 123
Previous Difference, 143
Print Preview, 116
Print Setup..., 116
Print..., 115
Redo, 118
Remove All Bookmarks, 124
Replace..., 119
Save, 115
Show Options Before Comparison, 145
Start Comparision, 143
Status Bar, 120
Support Recently Compared Pairs, 145
Synchronize Directories, 147
Synchronize Selected Directory, 147
Synchronized Scrolling, 121
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Text View, 120
Textual Comparison Only, 142
Toggle All Folds, 124
Toolbars, 120
Undo, 117
Validate, 141
Word Wrap, 123
Comparing,
directories, 62
files, 24
Office Open XM L, 24, 62
OOXM L, 24, 62
ZIP archives, 24, 62
Comparing directories,
see Directory comparison, 62
Comparing files,
see File comparison, 24
Comparison,
autostart, 93
definition, 16
selecting directories, 65
showing options before comparing, 93
Comparison management, 92
Comparison mode,
Binary, 18
changing, 66
current, 18
Extensions, 18
Quick comparison, 18
Text, 18
XM L, 18
Comparison Mode toolbar, 111
Comparison window status bar, 20
Comparisons,
saving, 88
Context menus,
customizing, 155
Copying,
file content, 82
Copyright information, 186
Creating,
attribute groups, 34
attributes filter, 36
elements filter, 36
groups of attributes, 34
Current comparison mode,
definition, 18
Customizing,
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Customizing,
Commands, 149
context menus, 155
Keyboard, 152
M enu, 155
Options, 157
tables, 46
Toolbars, 150

D
Default comparison mode, 105
Defining,
file extensions, 105
file types, 105
Deleting,
file extensions, 105
file types, 105
Diff and Merge menu, 142
directory comparison, 145
file comparison, 142
Diff and Merge toolbar, 111
DiffDog,
allowing multiple instances, 97
application window, 20
as Git differencing tool, 175
as TortoiseSVN differencing tool, 178
features, 14
GUI, 20
interface, 20
introduction to, 12
main features, 14
options, 96
settings, 96
terminology, 16
User Reference, 110
Differences,
colors, 99
copying content, 82
definition, 16
exporting, 86
in directories, 70
in files, 40
in Grid View, 44
in Text View, 40
in ZIP files, 70
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merging, 82
navigating, 80
within lines, 29
Directories,
comparing, 62
selecting for comparison, 65
synchronizing, 73
Directory comparison,
changing the comparison mode, 66
changing the synchronization actions, 75
changing the synchronization settings, 74
colors, 70
comparing files, 72
comparison mode, 18
comparison symbols, 70
configuring the view, 68
definition, 16
displaying differences, 70
displaying sub-directories, 68
features, 14
file icons, 70
filtering, 67
folder icons, 70
opening, 62
opening comparison window, 64
options, 66
running, 67
selecting directories, 65
starting, 67
starting a synchronization, 77
synchronizing directories, 73
ZIP icons, 70
Directory Comparison window,
filtering a comparison, 67
opening, 64
running a comparison, 67
selecting directories, 65
Directory Content toolbar, 111
Directory synchronization,
options, 74
running, 77
settings, 74
starting, 77
synchronization actions, 75
Displaying,
repeating elements, 46
sub-directories, 68
table, 46
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Displaying differences,
in directories, 70
in files, 40
in Grid View, 44
in Text View, 40
in ZIP archives, 70
Distribution,
of Altova's software products, 186, 187, 189

E
Edit menu, 117
Editing,
comparing while editing, 93
content, 48
files, 48
finding text, 50
replacing text, 50
structure, 49
Encoding, 97
End of line markers, 40
End User License Agreement, 186, 190
Entities,
resolving, 30
Equal files,
definition, 16
hiding, 68
showing, 68
Evaluation period,
of Altova's software products, 186, 187, 189
Expanding,
all selected nodes, 111
selected and child nodes, 111
sub-directories, 68
Exporting,
differences, 86
to text, 86
to XM L, 86

F
Features, 14
File comparison,
changing structure, 49
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comparing files in directory comparison, 72
comparing while editing, 93
comparison mode, 18
definition, 16
displaying differences, 40
editing content, 48
editing files, 48
features, 14
filter for XM L comparison, 36
finding text, 50
Grid View, 44
opening, 24
options, 29
reloading files, 48
replacing text, 50
running, 26
saving files, 60
searching Grid View, 55
starting, 26
Table View, 46
text comparison options, 29
Text View, 40
Text View Settings, 40
XM L comparison options, 30
File Comparison window,
running a comparison, 26
File menu, 113
Files,
automatic reloading, 99
backup options, 99
default comparison mode, 105
Filter,
creating, 103
default filters, 103
Filtering,
attributes, 36
directories, 67
elements, 36
XM L comparisons, 36
Find,
using regular expressions, 57
Finding,
content in Grid View, 55
names in Grid View, 55
text in file comparisons, 50
text in Grid View, 55
XM L node types, 55
Folding margin, 40
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G
Git,
Integrating DiffDog with, 175
Grid Edit toolbar, 111
Grid toolbar, 111
Grid View,
collapsing nodes, 111
displaying differences, 44
expanding nodes, 111
finding text, 55
optimal widths, 111
replacing text, 55
Grid View menu, 126
Add Child sub-M enu, 134
Append sub-menu, 130
Convert to submenu, 137
Insert sub-menu, 126
Table sub-menu, 137
GUI,
description, 20

H
Help menu, 161
Hiding,
equal files, 68
missing files left/right, 68
newer files left/right, 68
non-comparable files, 68
sub-directories, 68

I
Ignoring,
attribute order, 30
blank lines, 29, 30
case, 29, 30
namespace, 30
node depth, 30
node types, 30
node types order, 30
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prefixes, 30
text, 30
Indentation guides, 40
Interface,
description, 20
Introduction, 12

K
Keyboard shortcuts, 152

L
Legal information, 186
License, 190
information about, 186
License metering,
in Altova products, 188
Line number margin, 40

M
Margins,
bookmarks, 40
folding, 40
line numbers, 40
Menu bars,
customizing, 155
Menus,
adding commands, 149
Diff and M erge, 142
Edit, 117
File, 113
Grid View, 126
Help, 161
Text View, 123
Tools, 148
View, 120
Window, 159
XM L, 141
Merging,
definition, 16
differences, 82
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Missing files left/right,
hiding, 68
showing, 68
Modifying,
default comparison mode, 105
directory synchronization actions, 75
Grid View, 44
options for directory comparison, 66
options for file comparison, 29
settings for directory synchronization, 74
Multiple instances, 97
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directory synchronization, 74
encoding, 97
file comparison, 29, 99
file filters, 101
file types, 105
recently compared pairs, 94
showing before comparing, 93
startup options, 97
text comparison, 29
Windows Explorer integration, 97
XM L comparison, 30

N

P

Navigation,
current difference, 80
differences, 80
Newer files left/right,
hiding, 68
showing, 68
Non-comparable files,
hiding, 68
showing, 68
Non-equal files,
definition, 16

Product features, 14

O
Office Open XML,
comparing, 62
OOXML,
comparing, 62
Opening,
directory comparison, 62
Directory Comparison window, 64
empty directory comparison, 64
file comparison, 24
Options,
application, 97
backup files, 99
colors, 99
comparison management, 92
directory comparison, 66, 101
directory filters, 101

Q
Quick comparison mode,
definition, 18

R
Recently compared pairs, 94
Regular expressions,
find and replace using, 57
Reloading,
automatic reload, 99
files, 48
Replace,
using regular expressions, 57
Replacing,
text in file comparisons, 50
text in Grid View, 55
Resetting,
context menus, 155
menu bars, 155
Resolving entities, 30
Result messages, 166
Running,
directory comparison, 67
directory synchronization, 77
file comparison, 26
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S
Saving,
files, 60
Saving comparisons, 88
Selecting,
directories for comparison, 65
directories in Windows Explorer, 65
folders in Windows Explorer, 65
recently compared pairs, 94
Shortcuts, 152
Showing,
blank lines, 29, 30
differences within lines, 29
equal files, 68
large icons, 157
missing files left/right, 68
newer files left/right, 68
non-comparable files, 68
options before comparing, 93
recently compared pairs, 94
screen tips, 157
shortcut keys, 157
sub-directories, 68
text labels on toolbars, 150
Software product license, 190
Sorting,
tables, 46
Standard toolbar, 111
Starting,
directory comparison, 67
directory synchronization, 77
file comparison, 26
Startup options, 97
Status bar,
application, 20
comparison windows, 20
result message, 166
status messages, 166
Status messages, 166
Sub-directories,
collapsing, 68
displaying, 68
expanding, 68
hiding, 68
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including, 68
Synchonizing,
directories, 73
Synchronizing,
definition, 16
Syntax coloring, 105

T
Tab size, 40
Table View,
customizing, 46
displaying, 46
sorting, 46
Terminology, 16
Text comparison,
options, 29
showing differences within lines, 29
Text comparison mode,
definition, 18
Text toolbar, 111
Text View,
displaying differences, 40
Text View menu, 123
Text View Settings, 40
Toolbars, 111
adding commands, 149
Tools menu, 148
TortoiseSVN,
Integrating DiffDog with, 178

U
User Reference, 110

V
View menu, 120
Visual aid,
end of line markers, 40
indentation guides, 40
whitespace markers, 40
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W
Whitespace, 29, 30
Whitespace markers, 40
Window menu, 159
Windows Explorer integration, 97

X
XML comparison,
attribute groups, 34
detailed differencing, 30
filtering, 36
groups of attributes, 34
options, 30
XML comparison mode,
definition, 18
XML menu, 141

Z
ZIP archives,
comparing, 62
Zooming,
in Text View, 40
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